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Introduction

This guide describes the Mixer Module, an optional add-on package for
COMSOL Multiphysics® designed to assist you in setting up and solving transport
problems in mixers and stirred vessels. The module is an add-on to the CED
Module and provides additional support for modeling fluid flow in rotating

machinery.

This chapter introduces you to the capabilities of the module. A summary of the
physics interfaces and information about where to find documentation and model
examples is also included. This is followed by a brief overview with links to each
chapter in the guide. The last section in this introduction presents a tutorial model

from the Mixer Module Application Library.
This chapter contains the following sections:

¢ About the Mixer Module
e Overview of the User’s Guide

e Tutorial Model — Nonisothermal Mixer
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About the Mixer Module

The development of new products and processing lines continuously places high
demands on mixer design. The Mixer Module provides engineers and scientists with
the necessary simulation tools for predicting and understanding the interactions
between fluid flow and chemical processes in mixers and stirred vessels.

Figure 1-1: Water free surface in a partially baffled mixer with a three-bladed impeller.

The Mixer Module complements the CFD Module with additional functionality for
the Rotating Machinery, Fluid Flow branch. The added functionality includes
extended capability for modeling turbulence in the Rotating Machinery interfaces.

In order to facilitate fast and efficient setup of mixer geometries, the Mixer Module
Part Library includes predefined geometry components typical of mixer equipment.
The part library includes impeller parts for axial impellers, radial impellers, and
impellers designed for highly viscous fluids. In addition to impellers, three types of
different tank geometries and a cylindrical impeller shaft geometry are available in the

INTRODUCTION



part library. All mixer parts are modularized through a number of input parameters
corresponding to important geometrical properties of each part. These can be adjusted

in order to fit the mixer system under investigation.

A high rotation rate or a strong acceleration of the rotation rate may induce a
substantial deformation of the free surface in an open vessel. This topology change in
turn influences the flow pattern inside the vessel. The Mixer Module includes
free-surface features to capture the displacement of the liquid-air interface induced by

the bulk motion in the domain, by the walls, and by the rotating shaft.

The physics interfaces define a fluid-flow problem using physical quantities such as
pressure, flow rate, temperature, and species composition, as well as physical
properties, such as viscosity, thermal diffusivity, and density. The different physics
interfaces cover a wide range of laminar and turbulent mixer flows. The conservation
laws formulated by the physics interfaces are expressed in terms of partial differential
equations along with corresponding initial and boundary conditions. The equations
are solved by the module using stabilized finite element formulations for fluid flow in
combination with damped Newton methods and, for time-dependent problems, in
combination with various time-dependent solver algorithms. The Mixer Module’s
general capabilities include frozen-rotor and time-dependent flows in two- and
three-dimensional spaces. For a so-called frozen-rotor flow, the topology relative to
the rotating reference frame is fixed (“frozen”). When the flow field is, or can be
approximated to be, of this type the computational time (CPU time) can be
substantially reduced using the Frozen Rotor (see the CFD Module User’s Guide)

study type.

The workflow in the Mixer Module is quite straightforward. Set up a simulation using
one of the Rotating Machinery interfaces, described by the following steps: define the
geometry, select the fluid to be modeled, select the type of flow, define the rotating
parts,define boundary and initial conditions, define the finite element mesh, select a
solver, compute the solution, and visualize the results. All these steps are performed
from the COMSOL Desktop. The mesh and solver steps are usually carried out
automatically using default settings, which are tuned specifically for each Fluid Flow

interface.

The models available in the Mixer Module application library describe the physics
interfaces and their features through examples for different types of mixer flows. Here
you find examples of industrial equipment and devices, tutorial models for practice,
and benchmark models for verification and validation of the Fluid Flow interfaces. Go
to The Application Libraries Window to access these resources.

ABOUT THE MIXER MODULE
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To help you get started, this introduction contains a list of the physics interfaces and
an example, Tutorial Model — Nonisothermal Mixer, to introduce you to the

workflow.

ASPECTS OF MIXER SIMULATIONS

In the initial stages of development for a product, or a new process line, the focus
usually lies on qualitative results such as determining whether or not the flow is well
mixed, whether a heated reactor is free from hotspots, or whether the flow field
contains recirculation zones, which can be inaccessible to reactants. Qualitative results
such as these are usually the first step toward creating or improving a design. During
the later stages of development, the focus shifts toward scale-up and optimization. For
mixing of pseudoplastic slurries, for example, the yield stress has to be overcome
everywhere. Bioreactors, on the other hand, should not contain regions of excessive
shear. Obtaining accurate estimates for the yield stress, shear or other process
parameters such as reaction rates, thermal equilibration times, torque, and energy
consumption, provides developers with the edge needed to assume a competitive

position within their field.

The choice of which physics to include in your simulations can be based on
experimental results, experience, or a dimensional analysis. Excluding relevant physics
undoubtedly leads to wrong results, while including “everything” leads to excessive
computational time. The Rotating Machinery interfaces help you set up problems of
varying complexity. If the mixed quantity is passive, you can use one of the Rotating
Machinery, Fluid Flow interfaces to solve for the fluid flow, and then add a Transport
of Diluted Species interface to determine other properties, for example, the mixing
efficiency. Both reactions and thermal variations affect constitutive quantities, such as
the density and viscosity of the fluid. When these effects become appreciable, you can
switch to the Rotating Machinery, Reacting Flow interfaces or the Rotating
Machinery, Nonisothermal Flow interfaces. When working with Mach numbers larger
than 0.3, you can switch to the Rotating Machinery, High-Mach Number Flow
interfaces. When the mixed quantity consists of particles droplets or bubbles, possibly
with a different density and response time compared to the surrounding fluid, you can
switch to the Rotating Machinery, Multiphase Flow interfaces. In flows with many
particles or droplets immersed in a liquid, use the Rotating Machinery, Mixture Model
or Rotating Machinery, Phase Transport Mixture Model interfaces. If you are
interested in the exact motion of individual bubbles, including how the fluid interface
deforms due to, for instance, surface tension, use either the Rotating Machinery,
Two-Phase Flow, Level Set or the Rotating Machinery, Two-Phase Flow, Phase Field

INTRODUCTION



interfaces. Taking it one step further, COMSOL Multiphysics lets you add other

physics interfaces to preexisting ones to tailor simulations to your application.

The physics interfaces in the Mixer Module are able to perform all steps in mixer
analyses, from the initial idea and qualitative simulations to the final optimization of

the product or process.

The Mixer Module Physics Interface Guide

The Rotating Machinery interfaces in this module are based on the laws for
conservation of momentum, mass, and energy in fluids. The different physics
interfaces contain different combinations and expressions of the conservation laws,
which apply to the physics of the flow field being modeled. Figure 1-2 shows the
Rotating Machinery interfaces as they are displayed when you add a physics interface
(see Physics Interface Guide by Space Dimension and Study Type). A short description

of the various types of physics interfaces follows.

ABOUT THE MIXER MODULE
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Figure 1-2: The Rotating Machinery interfaces for laminar and turbulent flow in 3D.

ROTATING MACHINERY, FLUID FLOW

The Rotating Machinery, Laminar Flow interface

) is used primarily for modeling

flows of low to intermediate Reynolds numbers. This physics interface solves the
Navier-Stokes equations for incompressible (default), weakly compressible and
compressible flow (up to Mach 0.3). The physics interface is also capable of simulating

non-Newtonian fluid flow.
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The Rotating Machinery, Turbulent Flow interfaces (JE ) are used to model flow at high
Reynolds numbers. These physics interfaces solve the Reynolds-averaged
Navier-Stokes (RANS) equations for the averaged velocity field and averaged pressure.
The different physics interfaces in this branch have different models for the turbulent
viscosity. There are several turbulence models available — two algebraic turbulence
models, the Algebraic yPlus and L-VEL models, and seven transport-equation models,
including a standard %-& model, the Realizable £-& model, a £-® model, a SST model,
a low Reynolds number k-& model, the Spalart—Allmaras model, and the v2-f model.
Similarly to the Rotating Machinery, Laminar Flow interface, compressibility is set to

incompressible by default.

The Algebraic yPlus and L-VEL turbulence models are so-called enhanced viscosity
models. A turbulent viscosity is computed from the local distance to the nearest wall.
For this reason, the algebraic turbulence models are best suited for internal flows, such
as in electronic cooling applications. Algebraic turbulence models are computationally
economical, and more robust but, in general, less accurate than transport-equation
models. Among the transport-equation turbulence models, the standard &-€ model is
the most widely used turbulence model because it is often a good compromise between
accuracy and computational cost (memory and CPU time). The Realizable %-& model
is similar to the standard k-& model but has built-in realizability constraints, resulting
in improved performance for certain flows, such as turbulent jets. The - model is an
alternative to the standard k£-& model and often gives more accurate results, especially
in recirculation regions and close to solid walls. However, the £-0 model is also less
robust than the standard k- model. The SST model combines the robustness of the
k-g model with the accuracy of the £-® model, making it applicable to a wide variety
of turbulent flows. The low Reynolds number k-€ model is more accurate than the
standard k-€ model, especially close to walls, but requires higher resolution in the
near-wall region. The Spalart-Allmaras model is specifically designed for acrodynamic
applications, such as flow around wing profiles, but is also widely used in other
applications due to its high robustness and decent accuracy. In the v2-f model, the
turbulent viscosity is based on the wall-normal velocity fluctuations, whereby wall

blockage effects and low Reynolds number effects are captured separately. The v2-f

model also includes non-local effects of the fluctuating pressure on the turbulent fields.

ROTATING MACHINERY, MULTIPHASE FLOW

The Rotating Machinery, Mixture Model interfaces ( _l_) combine the functionality of the
Rotating Machinery, Fluid Flow and Mixture Model interfaces. The interfaces are
designed to study the flow of a two-phase mixture, consisting of a continuous phase

and a dispersed phase, in rotating and stationary domains. Both phases are assumed to

ABOUT THE MIXER MODULE
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be incompressible. The dispersed phase can be bubbles, liquid droplets, or solid
particles, which are assumed to always travel with their terminal velocity through the
continuous phase. Physics interfaces for both laminar flow and turbulent flow are
available. For turbulent flow the Reynolds-averaged Navier-Stokes (RANS) version of
the mixture model equations are solved, and all the turbulent models available for the

Rotating Machinery, Fluid Flow interfaces are also available.

The Rotating Machinery, Two-Phase Flow, Level Set interfaces (fl) combine the
functionality of the Rotating Machinery, Fluid Flow and Level Set interfaces. These
multiphysics interfaces are used to track the interface between two immiscible fluids in
geometries with one or more rotating parts. Wetted Wall and Interior Wetted Wall
multiphysics features are available for boundaries along which the interface between
the two fluids is expected to slide. Physics interfaces for both laminar flow and
turbulent flow are available. For turbulent flow the Reynolds-averaged Navier-Stokes
(RANS) equation is solved, and all the turbulent models for the Rotating Machinery,
Fluid Flow interfaces are available.

The Rotating Machinery, Two-Phase Flow, Phase Field interfaces (fi) combine the
functionality of the Rotating Machinery, Fluid Flow and Phase Field interfaces. These
multiphysics interfaces are used to track the interface between two immiscible fluids in
geometries with one or more rotating parts. Physics interfaces for both laminar flow
and turbulent flow are available. For turbulent flow the Reynolds-averaged
Navier-Stokes (RANS) equation is solved, and all the turbulent models for the

Rotating Machinery, Fluid Flow interfaces are available.

ROTATING MACHINERY, NONISOTHERMAL FLOW

The Rotating Machinery, Nonisothermal Flow, Laminar Flow interface (J) is used
primarily to model laminar flow where the temperature and flow fields have to be
coupled, such as in an externally heated mixer. This multiphysics interface has
predefined functionality for coupling heat transfer in fluids and solids. The weakly
compressible option is selected by default for the Rotating Machinery Nonisothermal

flow interfaces.

The Rotating Machinery, Nonisothermal Flow, Turbulent Flow interfaces (l) solve the
Reynolds-averaged Navier-Stokes (RANS) equations together with the equations for
heat transfer in fluids and in solids. There is support for all the fluid-flow turbulence
models - the Algebraic yPlus model, the L-VEL model, the standard k-& model, the
Realizable £-€ model, the £-® model, the SST model, a low Reynolds number &-¢
model, the Spalart-Allmaras model, and the v2-f model.

INTRODUCTION



ROTATING MACHINERY, HIGH-MACH NUMBER FLOW
The Rotating Machinery, High-Mach Number Flow interface (&3

)

model gas flows where one or more of the boundaries rotate in a periodic fashion and

is used primarily to

the velocity magnitude is comparable to the speed of sound in the gas; that is, it flows

in the transonic and supersonic range.

The Rotating Machinery, High-Mach Number Flow, Turbulent interfaces (-“-_..) solve the
Reynolds-averaged Navier-Stokes (RANS) equations together with the equation for
heat transfer in fluids. There is support for the £-€ model and the Spalart-Allmaras

model.

ROTATING MACHINERY, REACTING FLOW

The Rotating Machinery, Reacting Flow interfaces ( combine the functionality of the
Rotating Machinery, Fluid Flow and Transport of Concentrated Species interfaces.
The mass and momentum transport in a rotating reacting fluid can be modeled from
a single physics interface, and the couplings between the velocity field and mixture
density are set up automatically. Physics interfaces for both laminar flow and turbulent
flow using the Reynolds-averaged Navier-Stokes (RANS) equations are available.
There is support for the following turbulence models - the standard £-& model, the 2-®

model, the SST model, and the low Reynolds number &-€ model.

PHYSICS INTERFACE GUIDE BY SPACE DIMENSION AND STUDY TYPE
The list below shows the Rotating Machinery interfaces available with the Mixer

Module. Because the Mixer Module requires a license for CFD, additional physics
interfaces are listed in the CFD Module User’s Guide.

PHYSICS INTERFACE ICON |TAG SPACE AVAILABLE STUDY TYPE
DIMENSION

7:: Chemical Species Transport

Rotating Machinery, Reacting Flow

Laminar Flow — 3D, 2D, frozen rotor; time
dependent

JZ Turbulent Flow

Turbulent Flow, k-¢ lé — 3D, 2D frozen rotor; time
dependent

ABOUT THE MIXER MODULE
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Turbulent Flow, SST

PHYSICS INTERFACE ICON |TAG SPACE AVAILABLE STUDY TYPE
DIMENSION
Turbulent Flow, k-o Jé — 3D, 2D frozen rotor; time
dependent
Turbulent Flow, SST Jé — 3D, 2D frozen rotor with
initialization; time
dependent with
initialization
Turbulent Flow, Low Jé — 3D, 2D frozen rotor with
Re k-¢ initialization; time
dependent with
initialization
Rotating Machinery, spf 3D, 2D frozen rotor; time
Laminar Flow dependent
Rotating Machinery, JZ spf 3D, 2D frozen rotor with
Turbulent Flow, o initialization; time
Algebraic yPlus dependent with
initialization
Rotating Machinery, JZ spf 3D, 2D frozen rotor with
Turbulent Flow, L-VEL initialization; time
dependent with
initialization
Rotating Machinery, JZ spf 3D, 2D frozen rotor; time
Turbulent Flow, k-¢ dependent
Rotating Machinery, J; spf 3D, 2D frozen rotor; time
Turbulent Flow, dependent
Realizable k-¢
Rotating Machinery, Jé spf 3D, 2D frozen rotor; time
Turbulent Flow, k-0 dependent
Rotating Machinery, Jé spf 3D, 2D frozen rotor with

initialization; time
dependent with
initialization
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Re k-¢

PHYSICS INTERFACE ICON |TAG SPACE AVAILABLE STUDY TYPE
DIMENSION
Rotating Machinery, spf 3D, 2D frozen rotor with
Turbulent Flow, Low initialization; time
Re k- dependent with
initialization
Rotating Machinery, spf 3D, 2D frozen rotor with
Turbulent Flow, initialization; time
Spalart-Allmaras dependent with
initialization
Rotating Machinery, spf 3D, 2D frozen rotor with
Turbulent Flow, v2-f initialization; time
dependent with
initialization
- Rotating Machinery, Mixture Model
Mixture Model, — 3D, 2D frozen rotor, time
Laminar Flow dependent
Mixture Model, — 3D, 2D frozen rotor with
Algebraic yPlus initialization; time
dependent with
initialization
Mixture Model, L-VEL — 3D, 2D frozen rotor with
initialization; time
dependent with
initialization
Mixture Model, k-¢ — 3D, 2D frozen rotor, time
dependent
Mixture Model, — 3D, 2D frozen rotor, time
Realizable k-& dependent
Mixture Model, k-0 — 3D, 2D frozen rotor, time
dependent
Mixture Model, SST — 3D, 2D frozen rotor with
initialization; time
dependent with
initialization
Mixture Model, Low — 3D, 2D frozen rotor with

initialization; time
dependent with
initialization

ABOUT THE MIXER MODULE
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__:l}f Rotating Machinery,

Laminar Flow

Turbulent Flow,
Algebraic yPlus

Turbulent Flow, L-VEL

Turbulent Flow, k-
Turbulent Flow,
Realizable k-¢

Turbulent Flow, k-m

Turbulent Flow, SST

Turbulent Flow, Low
Re k-¢

Turbulent Flow,
Spalart-Allmaras

3D, 2D

3D, 2D

3D, 2D

3D, 2D

3D, 2D

3D, 2D

3D, 2D

3D, 2D

3D, 2D

PHYSICS INTERFACE ICON |TAG SPACE AVAILABLE STUDY TYPE
DIMENSION
Mixture Model, : — 3D, 2D frozen rotor with
Spalart-Allmaras o initialization; time
dependent with
initialization
Mixture Model, v2-f — 3D, 2D frozen rotor with

initialization; time
dependent with
initialization

frozen rotor, time
dependent

frozen rotor with
initialization; time
dependent with
initialization
frozen rotor with
initialization; time
dependent with
initialization
frozen rotor, time
dependent

frozen rotor, time
dependent

frozen rotor, time
dependent

frozen rotor with
initialization; time
dependent with
initialization
frozen rotor with
initialization; time
dependent with
initialization
frozen rotor with
initialization; time
dependent with
initialization

I8 | CHAPTER I: INTRODUCTION




PHYSICS INTERFACE

ICON |TAG SPACE
DIMENSION

AVAILABLE STUDY TYPE

Turbulent Flow, v2-f

={& Rotating Machinery,

Laminar Two-Phase
Flow, Level Set

Two-Phase Flow, Level
Set, Algebraic yPlus

Two-Phase Flow, Level
Set, L-VEL

Two-Phase Flow, Level
Set, k-

Two-Phase Flow, Level
Set, Realizable k-¢

Two-Phase Flow, Level
Set, k-0

Two-Phase Flow, Level
Set, SST

Two-Phase Flow, Level
Set, Low Re k-¢

Two-Phase Flow, Level
Set, Spalart-Allmaras

Two-Phase Flow, Level
Set, v2-f

=}4 Rotating Machinery,

Laminar Two-Phase
Flow, Phase Field

Two-Phase Flow, Phase
Field, Algebraic yPlus

Two-Phase Flow, Phase
Field, L-VEL

3D, 2D

Two-Phase Flow, Level Set

F |— 3D,2D
W |— 3D,2D
W |— 3D,2D
W |- 3D, 2D
W |- 3D, 2D
= 3D, 2D
|- 3D,2D
o |— 3D,2D
W |— 3D,2D
W |- 3D, 2D

Two-Phase Flow, Phase Field

|- 3D,2D
W |— 3D, 2D
W |- 3D, 2D

frozen rotor with
initialization; time
dependent with
initialization

time dependent with phase
initialization

time dependent with
initialization

time dependent with
initialization

time dependent with phase
initialization

time dependent with phase
initialization

time dependent with phase
initialization

time dependent with
initialization

time dependent with
initialization

time dependent with
initialization

time dependent with
initialization

time dependent with phase
initialization

time dependent with
initialization

time dependent with
initialization
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PHYSICS INTERFACE ICON |TAG SPACE AVAILABLE STUDY TYPE
DIMENSION
Two-Phase Flow, Phase fl — 3D, 2D time dependent with phase
Field, k-¢ initialization
Two-Phase Flow, Phase fl — 3D, 2D time dependent with phase
Field, Realizable k- initialization
Two-Phase Flow, Phase fl — 3D, 2D time dependent with phase
Field, k-0 initialization
Two-Phase Flow, Phase fl — 3D, 2D time dependent with
Field, SST initialization
Two-Phase Flow, Phase fl — 3D, 2D time dependent with
Field, Low Re k-¢ initialization
Two-Phase Flow, Phase fl — 3D, 2D time dependent with
Field, Spalart-Allmaras initialization
Two-Phase Flow, Phase fl — 3D, 2D time dependent with

Field, v2-f

1 Rotating Machinery, Nonisothermal Flow

Laminar Flow

Turbulent Flow,
Algebraic yPlus

Turbulent Flow, L-VEL

Turbulent Flow, k-¢

Turbulent Flow,
Realizable k-¢

Turbulent Flow, k-m

3D, 2D

3D, 2D

3D, 2D

3D, 2D

3D, 2D

3D, 2D

initialization

frozen rotor; time
dependent

frozen rotor with
initialization; time
dependent with
initialization
frozen rotor with
initialization; time
dependent with
initialization
frozen rotor; time
dependent

frozen rotor; time
dependent

frozen rotor; time
dependent
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PHYSICS INTERFACE ICON |TAG SPACE AVAILABLE STUDY TYPE
DIMENSION

Turbulent Flow, SST l — 3D, 2D frozen rotor with
initialization; time
dependent with
initialization

Turbulent Flow, Low l — 3D, 2D frozen rotor with

Re k-¢ initialization; time
dependent with
initialization

Turbulent Flow, l — 3D, 2D frozen rotor with

Spalart-Allmaras initialization; time
dependent with
initialization

Turbulent Flow, v2-f l — 3D, 2D frozen rotor with

initialization; time
dependent with
initialization

fi¥5 Rotating Machinery, High Mach N

umber Flow

High Mach Number
Flow, Laminar

High Mach Number
Flow, k-¢

High Mach Number
Flow, Spalart-Allmaras

1]

=5
e

3D, 2D

3D, 2D

3D, 2D

frozen rotor; time
dependent

frozen rotor; time
dependent

frozen rotor with
initialization; time
dependent with
initialization

Fluid-Structure Interaction

Where Do I Access the Documentation?

A number of internet resources have more information about COMSOL, including

licensing and technical information. The electronic documentation, topic-based (or
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context-based) help, and the application libraries are all accessed through the
COMSOL Desktop.

Ifyou are reading the documentation as a PDF file on your computer,
the blue links do not work to open an application or content

n referenced in a different guide. However, if you are using the Help
system in COMSOL Multiphysics, these links work to open other

modules, application examples, and documentation sets.

THE DOCUMENTATION AND ONLINE HELP

The COMSOL Multiphysics Reference Manual describes the core physics interfaces
and functionality included with the COMSOL Multiphysics license. This book also has
instructions about how to use COMSOL Multiphysics and how to access the
electronic Documentation and Help content.

Opening Topic-Based Help

The Help window is useful as it is connected to the features in the COMSOL Desktop.
To learn more about a node in the Model Builder, or a window on the Desktop, click
to highlight a node or window, then press F1 to open the Help window, which then
displays information about that feature (or click a node in the Model Builder followed
by the Help button ( [ ). This is called zopic-based (or context) help.

To open the Help window:
¢ In the Model Builder, Application Builder, or Physics Builder click a node or
window and then press F1.

* On any toolbar (for example, Home, Definitions, or Geometry), hover the
Win mouse over a button (for example, Add Physics or Build All) and then

press F1.
* From the File menu, click Help ( B )-

¢ Inthe upper-right corner of the COMSOL Desktop, click the Help ( 1 )
button.

CHAPTER I:
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To open the Help window:

¢ In the Model Builder or Physics Builder click a node or window and then
press F1.

¢ On the main toolbar, click the Help ( [ ) button.

e From the main menu, select Help>Help.

Opening the Documentation Window

To open the Documentation window:

Win e Press Ctrl+F1.

¢ From the File menu select Help>Documentation ( I!I ).

To open the Documentation window:

¢ Press Ctrl+F1.

* On the main toolbar, click the Documentation ( || ) button.
Linux

¢ From the main menu, select Help>Documentation.

THE APPLICATION LIBRARIES WINDOW

Each model or application includes documentation with the theoretical background
and step-by-step instructions to create a model or application. The models and
applications are available in COMSOL Multiphysics as MPH files that you can open
for further investigation. You can use the step-by-step instructions and the actual
models as templates for your own modeling. In most models, SI units are used to
describe the relevant properties, parameters, and dimensions, but other unit systems
are available.

Once the Application Libraries window is opened, you can search by name or browse
under a module folder name. Click to view a summary of the model or application and

its properties, including options to open it or its associated PDF document.

The Application Libraries Window in the COMSOL Multiphysics
E}‘ Reference Manual.
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Opening the Application Libraries Window
To open the Application Libraries window ( |]]]] ):

* From the Home toolbar, Windows menu, click ([[[]] ) Applications
Libraries.
Win ¢ From the File menu select Application Libraries.
To include the latest versions of model examples, from the File>Help
menu, select ([} ) Update COMSOL Application Library.

To include the latest versions of model examples, from the Help menu

Select Application Libraries from the main File> or Windows> menus.

Linux select ( E“'j ) Update COMSOL Application Library.

CHAPTER I:

CONTACTING COMSOL BY EMAIL

For general product information, contact COMSOL at info@comsol.com.

COMSOL ACCESS AND TECHNICAL SUPPORT

To receive technical support from COMSOL for the COMSOL products, please
contact your local COMSOL representative or send your questions to
support@comsol.com. An automatic notification and a case number are sent to you by
email. You can also access technical support, software updates, license information, and

other resources by registering for a COMSOL Access account.

INTRODUCTION



COMSOL ONLINE RESOURCES

COMSOL website
Contact COMSOL
COMSOL Access
Support Center
Product Download
Product Updates
COMSOL Blog
Discussion Forum
Events

COMSOL Application Gallery
COMSOL Video Gallery

Support Knowledge Base

www.comsol.com
www.comsol.com/contact
www.comsol.com/access
www.comsol.com/support
www.comsol.com/product-download
www.comsol.com/support,/updates
www.comsol.com/blogs
www.comsol.com/community
www.comsol.com/events
www.comsol.com/models
www.comsol.com/video

www.comsol.com /support,/knowledgebase

ABOUT THE MIXER MODULE |

25


https://www.comsol.com
https://www.comsol.com/contact/
https://www.comsol.com/access
https://www.comsol.com/support/
https://www.comsol.com/product-download/
https://www.comsol.com/support/updates
https://www.comsol.com/blogs/
https://www.comsol.com/community
https://www.comsol.com/events/
https://www.comsol.com/models/
https://www.comsol.com/video/
https://www.comsol.com/support/knowledgebase/

2 |

Overview of the User’s Guide

The Mixer Module User’s Guide gets you started with modeling using COMSOL
Multiphysics and provides information specific to this module. Further instructions on
using COMSOL Multiphysics in general are found in the COMSOL Multiphysics
Reference Manual.

As detailed in the section Where Do I Access the Documentation? this
'g' information can also be found from the COMSOL Multiphysics software

Help menu.

CHAPTER I:

For general information about setting up and solving CFD applications, see the CFD
Module User’s Guide.

The last section in this chapter features a model you can access from The Application
Libraries Window. The Tutorial Model — Nonisothermal Mixer solves a mixer-flow
problem using the Laminar Flow interface in the Rotating Machinery, Nonisothermal

Flow branch.

The following chapter documents the Mixer Module Part Library. It includes an

overview of all the included impellers and tanks.

The third chapter introduces you to the Theory for the Free Surface Features. It
includes descriptions of the mesh deformation within the free surface domain and the
conditions that need to be satisfied at a free surface, at a three-phase boundary, and on

a rotating shaft within the free surface domain.

The remaining chapters describe the physics interfaces and features under the Rotating
Machinery, Fluid Flow branch, and the additional branches exclusive to the Mixer
Module: Rotating Machinery, Multiphase Flow Interfaces, Rotating Machinery,

Nonisothermal Flow Interfaces, and Rotating Machinery, Reacting Flow Interfaces.

INTRODUCTION



Tutorial Model — Nonisothermal
Mixer

This model demonstrates how to obtain the temperature distribution in a simplified
tabletop lab mixer using the Rotating Machinery, Nonisothermal Flow branch in the
Mixer Module. The key instructive element is a demonstration of the Frozen Rotor

method, which substantially reduces the computational time for a mixing study.

The model geometry is shown in Figure 1-3. It represents a cross-section of a tabletop
lab mixer. Small mixers are not always baffled. Instead, one or several rods are inserted
through the mixer lid and function as baffles. The rods typically contain equipment to
measure, for example, the temperature or pH level. In this model, the mixer is baffled

by a simplified immersion heater, which has a constant surface temperature of 60°C.

Immersion heater =

0.17]

0.087|

0.067|

0.047]

0.027]

Rotational
direction

-0.027]

-0.047]

-0.067|

-0.087]

-0.17]

T T T T T
-0.1 -0.05 0 0.05 0.1

Figure 1-3: Tabletop lab mixer geometry, showing the rotational divection of the impeller
and the location of the immersion heater.
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The mixer tank is filled with water which is agitated by the impeller rotating clockwise
(as indicated in Figure 1-3) with 20 revolutions per minute (rpm). In this model the
thickness of the impeller blades is significantly smaller than the diameter of the tank,

and the impeller blades are therefore modeled as infinitely thin.

The tank is made of steel and is subjected to cooling by natural convection on the

outside of the mixer vessel. The surrounding conditions corresponds to a temperature
of 20°C and a pressure of 1 atmosphere. The total height of the reactor is 0.2 m. These
conditions are needed as input for the natural convection correlations, which are used

to calculate the heat transfer coefficient from the tank wall to the surroundings.

MODEL SETUP

The Reynolds number for a mixer is commonly calculated as

ND?
Re =

" (1-1
where N is the number of rotations per second, D, the impeller diameter, and v the
kinematic viscosity. A high Reynolds number means that the flow has a tendency to
become turbulent. Evaluating Equation 1-1 using v at 60 °C gives Re = 6944. This
Reynolds number indicates that the flow is at least partly turbulent. For simplicity in
this instructional model, the flow is assumed to be two-dimensional and no turbulence
model is used. Possible extensions of the model includes to resolve it using the full
three dimensional geometry, and also to apply a turbulence model to investigate the

effect of turbulent structures occurring in the flow.

The objective of this model is to obtain the temperature distribution at operating
conditions. One way to get there would be to start from zero velocity and a
homogeneous temperature distribution and to simulate the startup of the mixer. This

approach is simple but requires a relatively long computation time.

A computationally more efficient method is to first simulate the flow using the
frozen-rotor approach. The frozen-rotor approach is a modeling concept that treats
the rotor as fixed, or frozen in space. The flow in the rotating domain is assumed to be
stationary in terms of a rotating coordinate system. The effect of the rotation is then
accounted for by the Coriolis and centrifugal forces. The flow in the nonrotating parts
is also assumed to be stationary, but in a nonrotating coordinate system (see Frozen
Rotor in the CFD Module User’s Guide for more information). The result of a
frozen-rotor simulation is an approximation to the flow induced by the impeller. The
result depends on the angular position of the impeller and cannot represent transient

effects. However, it is still a very good starting point to reach operating conditions.

INTRODUCTION



Here the frozen-rotor result is used as input to a time-dependent simulation and the

progress toward the operating conditions is monitored using probe plots.

RESULTS AND DISCUSSION

Figure 1-4 shows the velocity distribution obtained from the frozen-rotor simulation.
As expected, the highest velocity magnitude is found at the tip of the mixer blades.
Three recirculation zones can be identified: one downstream of the immersion heater,

one along the top wall, and one along the bottom wall.

Surface: Velocity magnitude (m/s) Streamline: Velocity field (spatial frame)

m T T T T T

0.1 B
0.08

0.08 B
0.07

0.06 - —
0.04 - i 0.06
0.021 7 0.05

ok -
0.04

-0.02 B
0.03

-0.04 - 1 [

-0.06 | . 0.02
-0.08 B 0.01

0.1k -

1 1 1 1 1 0

=0.1. -0.05 0 0.05 0.1 m
Figure 1-4: Velocity field obtained from the frozen rotor simulation.

Figure 1-5 shows the temperature distribution obtained from the frozen-rotor
simulation. Streamlines are also included to visualize the flow field. The temperature
is relatively homogeneous throughout the mixer. There are some cold spots in
connection to the recirculation zones adjacent to the outer wall. This is expected
because the fluid there has a longer residence time close to the solid wall, and therefore
has less contact with the heated fluid closer to the center of the mixer.
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Surface: Temperature (K) Streamline: Velocity field (spatial frame)
m T T T T T

01F  Probe point

0.08 -

0.06 -

0.02

-0.02

-0.04 -

-0.06 -

-0.08 -

-0.1F

1 1 1 1 1
-0.1 -0.05 0 0.05 0.1 m

Figure 1-5: Temperature distribution obtained from the frozen-rotor simulation.

The progress of a solution can be monitored using probes (see Probes in the COMSOL
Multiphysics Reference Manual). The velocity magnitude and temperature are
probed at (x,y) = (—0.05,0.065). The location is indicated in Figure 1-5, just outside
the recirculation zone along the top wall.

The probe plots produced during the time-dependent simulation are shown in
Figure 1-6. The velocity probe plot shows that the flow pattern, after an initial
transient, oscillates around the frozen-rotor result with an amplitude of about 10%.
The deviations in temperature are much smaller.

The velocity probe plot clearly shows the frequency that corresponds to the passing of
the blades (0.75 Hz) and an additional frequency (about 0.25 Hz) related to the
intermittent boundary-layer separation. Evaluating the frequency from the Strouhal
number for the immersion heater gives a value of about 0.25 Hz, suggesting that the
boundary-layer separation may be induced by the Kirmén vortex street behind the
heater. The temperature value does not display the same frequencies and instead
changes more smoothly.
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Figure 1-6: Probe plots of velocity and temperature in the mixer from the time-dependent

simulation.
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A more complete picture of the progress from the frozen-rotor solution toward the
operating conditions can be seen through an animation. Figure 1-7 shows four
snapshots from such an animation. The time runs from top left to lower-right. The
most notable changes occur in the recirculation zones. The recirculation zone behind
the immersion heater has two vortices which appear to be oscillating. This has no effect
on the local temperature, but it significantly influences the size of the recirculation

zones adjacent to the outer wall.

Looking at Figure 1-5, it can be seen that the recirculation zone along the top wall

contains a single, large vortex. As the simulation progresses (£ =20 s to ¢ =40 s), the
size and strength and position of the vortices along the top wall varies as a result of the
interaction between the disturbance, produced by the immersion heater, and the outer

wall.
Time=10s Surface: Temperature (K) Time=20s Surface: Temperature (K)
Streamline: Velocity field (spatial frame) Streamline: Velocity field (spatial frame)
m m
01 01 —
908 b 333 908 b 333
0.06 - - 0.06 - —
0.04 - - 332 0.04 - — 332
0.02 - 0.02 —
or b 331 af T 331
-0.02 - - -0.02 - —
-0.04 - B -0.04 - B
330 330
-0.06 - — -0.06 - —
-0.08 - — -0.08 - —
329 329
Dl 1 Dl 1
-0.1 -0.05 0 0.05 01l m -0.1 -0.05 0 0.05 01l m
Time=30s Surface: Temperature (K) Time=40s Surface: Temperature (K)
Streamline: Velocity field (spatial frame) Streamline: Velocity field (spatial frame)
m m
01 01
908 b 333 908 b 333
0.06 - — 0.06 - —
0.04 - — 332 0.04 - - 332
0.02 — 0.02 —
or T 331 or T 331
-0.02 - — -0.02 - —
-0.04 - B -0.04 - B
330 330
-0.06 - — -0.06 - —
-0.08 - — -0.08 - —
329 329
Dl 1 Dl 1
-0.1 -0.05 0 0.05 01l m -0.1 -0.05 0 0.05 01l m

Figure 1-7: Evolution of the temperature field from frozen votor solution toward operating
conditions.

The results obtained in this model are typical for rotating-machinery models: The
frozen-rotor approach can, with minimal computational effort, deliver a decent
approximation of the flow and temperature fields. But transient effects can only be
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captured with a time-dependent simulation, and these effects can change local

temperature and velocity values significantly.

The remainder of this section consists of step-by-step instructions on setting up,

solving, and analyzing the model using both analysis types.

MODEL WIZARD

The first step to build a model is to open COMSOL Multiphysics, then select the
physics interface and specify the type of analysis you want to do — in this case, a
frozen-rotor analysis using a Rotating Machinery, Nonisothermal Laminar Flow

interface.
I Open COMSOL Multiphysics. In the New window, click Model Wizard ). Then
click the 2D button €.

2 In the Select Physics tree, under Fluid Flow>Nonisothermal Flow>Rotating Machinery,

Nonisothermal Flow click Laminar Flow l
3 Click the Add button.
4 Click the Study button .

5 In the Select Study tree, select
Preset Studies for Selected Physics Interfaces>Frozen Rotor | — .

6 Click the Done button [ .

CREATE THE GEOMETRY

To simplify this step, insert a prepared geometry sequence.

I In the Geometry toolbar, select Insert Sequence E‘a

2 Browse to the module’s applications folder and double-click the file
nonisothermal_mixer.mph.
3 Go to the Home toolbar and select Build All 5 . The Home toolbar refers to the

specific set of controls near the top of the Desktop.

4 Click the Zoom Extents button on the Graphics toolbar.

Note that the boundary between the rotating and the nonrotating domain is an
assembly boundary so that the parts can move relative to each other in the

time-dependent simulation.

MATERIALS
In the Home toolbar, click Add Material :f; to open the Add Material window.

TUTORIAL MODEL — NONISOTHERMAL MIXER
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Water, liquid

I Go to the Add Material window.

Add Materia

- R X

() Add to Global Materials =+ Add to Component ~

58 Structural steel

25 Thermal grease

=& Titanium beta-215
22 Tungsten

o= Water, liquid

b % AC/DC

|+ <3 Batteries and Fuel Cells

I @) Bicheat

Search

2 In the tree, select Built-In>Water, liquid.

3 In the Add Material window, click Add to Component —- .

Steel AlISI 4340
I Go to the Add Material window.

In the tree, select Built-In>Steel AISI 4340.

In the Add Material window, click Add to Component —|- .

2
3
4 In the Home toolbar, click Add Material :Z: again to close the Add Material window.
5

In the Model Builder window, under Component | (compl)>Materials> click
Steel AISI 4340.

6 Sclect Domain 1, the circular outer rim of the mixer, only.

There are many ways to select geometric entities. When you know the domain to add,

such as in this exercise, you can click the Paste Selection button ffj and enter the

information in the Selection text field. In this example, enter 1 in the Paste Selection

window. For more information about selecting geometric entities in the Graphics
window, see the COMSOL Multiphysics Reference Manual.

3 Paste Selection

Selection:

QK

Cancel

s
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DEFINITIONS

Rotating Domain |
I In the Model Builder window, under Component | (compl)>Moving Mesh click
Rotating Domain |I.

I In the Settings window for Retating Domain, locate the Domain Selection section.

2 In the list, choose I and 2.
3 Click Remove from Selection = . Only domain 3, the impeller domain, is selected.
4 In the Settings window for Rotating Domain, locate the Rotation section.
5 In the Revolutions per time text field, type -20[rpm].
¥ Rotation
Rotation type:
Specified rotational velocity ~

Rotational velocity expression:

General revolutions per time "
Revolutions per time:
f o -20[rpm] /s

Initial angle:

LAMINAR FLOW (SPF)

I In the Model Builder window, under Component | (compl) click Laminar Flow (spf).

2 In the Settings window for Laminar Flow, locate the Domain Selection section.

3 In the list, select I.

4 Click Remove from Selection = . Only domains 2 and 3, the fluid domains, are
selected.

Interior Wall |

I In the Physics toolbar, click Boundaries £ and choose Interior Wall —.

2 Select Boundaries 17-20 only, corresponding to the impeller blades.

@' Paste Selection *

Selection:  17-20
oK Cancel

Pressure Point Constraint |

I In the Physics toolbar, click Points  and sclect Pressure Point Constraint .
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2 Select Point 5 only. This is the bottommost point in the fluid domain of the mixer.

HEAT TRANSFER IN FLUIDS (HT)
In the Model Builder window, under Component | (compl) click
Heat Transfer in Fluids (ht).

Solid |

I In the Physics toolbar, click Domains @ and choose Solid @D .

2 Select Domain 1, the mixer vessel wall, only.

Temperature |

I In the Physics toolbar, click Boundaries ) and select Temperature .

2 Select Boundaries 13-16, which make up the boundary of the immersion heater.
3 In the Settings window for Temperature, locate the Temperature section.

4 In the T text field, type 60[degC].

Heat Flux |

I In the Physics toolbar, click Boundaries £ and choose Heat Flux —.

2 Select Boundaries 1,2, 7, and 12, which make up the circular outer boundary of the

mixer vessel.

3 In the Settings window for Heat Flux, locate the Heat Flux section.

4 Click the Convective heat flux button.

5 From the Heat transfer coefficient list, choose External natural convection.
6 In the L text field, type 0.2[m].

MESH |

I In the Model Builder window, under Component | (compl) click Mesh 1 /. .

2 In the Settings window for Mesh, locate the Physics-Controlled Mesh section.

3 From the Element size list, choose Fine.

The default mesh generates isotropic mesh elements across the thin vessel wall. Edit
the Physics-controlled mesh settings to increase the element size in the circumferential
direction of the solid domain.

I Go to the Mesh toolbar and click Edit /£y .

2 In the Model Builder window, under Component | (compl)>Mesh | click Size ,ﬁE

3 In the Settings window for Size, locate the Element Size section.

4 From the Predefined list, choose Coarse.
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To avoid unnecessarily small elements in the mixer vessel wall, add a separate Size node

with reduced resolution in narrow regions.

Size |
I Right-click Component I (compl)>Mesh |1>Free Triangular | [, and choose

Size fﬁE

In the Settings window for Size, locate the Geometric Entity Selection scction.
From the Geometric entity level list, choosc Domain.
Select Domain 1, the vessel wall, only.

Locate the Element Size section. Click the Custom button.

o U1 A W N

Locate the Element Size Parameters section. Select the Resolution of narrow regions
check box.

7 In the associated text field, type 0. 1.

Build the Free Triangular | mesh node in order to inspect the mesh at this point.
8 In the Settings window for Size I, click the Build Selected button &

Now add the mesh boundary layers as well. Use boundary layer mesh also in the solid

domain to increase the resolution there.

Boundary Layers |
I In the Model Builder window, under Component | (compl)>Mesh | click
Boundary Layers | .

2 In the Settings window for Boundary Layers, locate the Domain Selection section.
3 From the Selection list, choose All domains.
4 In the Settings window for Boundary Layers, click the Build Selected button = .

Now that the physics is defined and the geometry is meshed, solve the model using the

frozen rotor approach.

STUDY 1

In the Home toolbar, click Compute = .

RESULTS

Re-create Figure 1-4 using the following steps.

Velocity (spf)
I In the Model Builder window, under Results @ , click the Velocity (spf) node.

2 Right-click Velocity (spf) and choose Streamline === .
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3 In the Settings window for Streamline, locate the Streamline Positioning section.

¥ Streamline Positioning

Positioning: Uniform density =
Separating distance: 0.015

Advanced parameters:  Automatic =

¥ Coloring and Style

Line style
Type: Line =
Point style
Type: MNone =
Color White -

4 From the Positioning list, choose Uniform density.
5 In the Separating distance text field, type 0.015.

6 Locate the Coloring and Style section. Find the Point style subsection. From the Color
list, choose White.

7 In the Velocity (spf) toolbar, click Plot .
8 Click the Zoom Extents button in the Graphics toolbar.

Temperature (ht)
Figure 1-5 can be created by the following steps.

I In the Model Builder window, expand the Results>Temperature (ht) node, then click

Surface .

In the Settings window for Surface, locate the Coloring and Style section.

From the Color table list, choosec Wave.

Go to the Temperature (ht) toolbar and select Streamline ===

In the Settings window for Streamline, locate the Streamline Positioning section.
From the Positioning list, choose Uniform density.

In the Separating distance text field, type 0.015.

0 N o0 1 A W N

Locate the Coloring and Style section. Find the Point style subsection. From the Color
list, choose Gray.

9 In the Temperature (ht) toolbar, click Plot .

Add a probe to follow the development of the flow during the time-dependent

simulation.

INTRODUCTION



DEFINITIONS

Domain Point Probe |

I In the Definitions toolbar, click Probes "7@ and choose Domain Point Probe %"

2 In the Settings window for Domain Point Probe,

locate the Point Selection section.

3 In the Coordinates text field, set x to -0.05[m].

4 In the Coordinates text ficld, sety to 0.065[m].

The probe is located at the outer edge of the recirculation zone that is positioned

along the upper wall. By default the flow field velocity magnitude is tracked by the

probe.

NV 0 N o n

choose New window.

In the Model Builder window, expand the Domain Point Probe |1 node :z:h'.
Right-click Point Probe Expression | (ppbl) /@ and choose Duplicate.

In the Settings window for Point Probe Expression, locate the Expression section.
In the Expression text field, type T, in order to track the temperature variable.

Click to expand the Table and Window Settings scction. From the Plot window list,

Add a Time Dependent study in order to perform a transient simulation, using the

previous solution as initial condition.

ADD STUDY

I In the Home toolbar, click Add Study :\‘j:i to open the Add Study window.

2 Go to the Add Study window.

3 In the tree, select General Studies>Time Dependent [\%.

4 In the Add Study window, click Add Study —- .

5 In the Home toolbar, click Add Study "\‘j:i again to close the Add Study window.

STUDY 2

Step |: Time Dependent

I In the Model Builder window, under Study 2 click Step 1: Time Dependent &

2 In the Settings window for Time Dependent, locate the Study Settings section.

TUTORIAL MODEL — NONISOTHERMAL MIXER
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3 In the Output times text field, type range(0,0.5,40).

This means that the solution will be computed from t = 0 to 40 s, and the solution

will be stored every 0.5 seconds.

Now, apply the solution from the previous frozen rotor analysis as initial condition
for the transient simulation.

4 Click to expand the Values of Dependent Variables section. Find the
Initial values of variables solved for subsection. From the Settings list, choose

User controlled.
5 From the Method list, choose Solution.
6 From the Study list, choose Study I, Frozen Rotor.
For the transient simulation, add a restriction on the time step. This will make sure that

the impeller rotation in each time step is bounded, and that a high accuracy is

maintained throughout the simulation. First generate the solver sequence.
Solution 2
I In the Study toolbar, click Show Default Solver M.

2 In the Model Builder window, expand the Solution 2 (sol2) node, then click
Time-Dependent Solver | |_E
Apply a maximum time step of 0.05 s. This is equivalent to an impeller rotation of
6°.

3 In the Settings window for Time-Dependent Solver, click to expand the Time Stepping
section.

4 From the Maximum step constraint list, choose Constant.

5 In the Maximum step text field, type 0.05.

6 In the Study toolbar, click Compute = .

Two probe plots are automatically displayed when you start the calculation.

RESULTS

The following steps create an animation that contains the plots in Figure 1-7.

Temperature (ht) |

I In the Model Builder window, under Results @ , click Temperature (ht) | . .

2 In the Settings window for 2D Plot Group, locate the Plot Settings section.
Plot the dataset edges in the spatial frame to make them follow the rotation.

3 From the Frame list, choose Spatial (x, y, z).

INTRODUCTION



Surface
I In the Model Builder window, expand the Temperature (ht) | . node, then click

Surface .

2 In the Settings window for Surface, locate the Coloring and Style section.
3 From the Color table list, choose Wave.
Streamline |
I Go to the Temperature (ht) | toolbar and choose Streamline == .
2 In the Settings window for Streamline, locate the Streamline Positioning section.
3 From the Peositioning list, choose Uniform density.
4 In the Separating distance text field, type 0.015.
5 Locate the Coloring and Style section. Find the Point style subsection. From the Color
list, choose Gray.
Animation |
I Go to the Results toolbar, click Animation [ and choose File (L.
In the Settings window for Animation, locate the Target section.
From the Target list, choose Player.
Locate the Scene section. From the Subject list, choose Temperature (ht) I.

2

3

4

5 Locate the Frames section. From the Frame selection list, choose All.

6 Locate the Playing section. In the Display each frame for text field, type 0.25.
7

In the Graphics window, click Play [*].

TUTORIAL MODEL — NONISOTHERMAL MIXER ‘
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Mixer Module Part

In this chapter:

* Dart Library Contents
* Tank Parts

e Impeller Parts

Library
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Part Library Contents

CHAPTER 2:

The dedicated part library included in the Mixer Module contains geometrical parts
typical of mixer and stirred vessel equipment. The included parts consists of impellers,
tanks, and a straight cylindrical shaft. When accessing the library, the parts are sorted
under the categories seen in the figure below.

Part Libraries
[ Search |

3 COMSOL Multiphysics
4 l Mixer Module
m]] Impellers, Axial
[l 1mpellers, Highly Viscous Fluids
m]] Impellers, Radial
[iiff shafts
m]] Tanks

Figure 2-1: The Mixer Module Part Library

The dimensions and configuration of the different parts can be controlled to a great
detail using the input parameters included in each part. For example, adding a pitched
impeller part instance, you can cut different parts of the impeller, round its edges,
define the pitch angle, and define asymmetrical blades, which are wider above the
rotation plane than below. Also several impellers can be added, and also rotate them
slightly around the rotational axis in order to evenly distribute the blades in the

circumferential direction.
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Tank Parts

The Mixer Module Part Library includes three different cylindrical tanks: a dished
bottom tank, a flat bottom tank, and a cone bottom tank. The three tank types are
shown in the figure below.

Dished bottom tank Flat bottom tank Cone bottom tank

Figure 2-2: Tank parvts available in the Mixer Module Part Library.

All tank parts can be defined to include an optional number of baffles in order to
improve mixing. Baffles are specially required when radial impellers are used, in order
to avoid a near solid body rotation of the fluid.

By default, the tank’s cylindrical part is positioned with its base at z = 0. This implies
that the dished and cone bottom sections are positioned just below the xy-plane. If you
define a flat bottom tank with a fillet radius on the lower cylinder edge, then also the
fillet section created is placed just below the xy-plane. If you specify a zero fillet radius
for a flat bottom tank, then the base of the tank is positioned in the xy-plane, that is,
atz = 0.

The impeller shaft’s lowest part is also by default positioned at z = 0. You can change
the position, length, and diameter of the impeller shaft. However, the impeller shaft is
always placed in the middle of the tank perpendicular to the xy-plane.

TANK PARTS
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Impeller Parts

As seen in Figure 2-1, the impeller parts are sorted into three categories, depending
on the principal direction of the flow generated by the impeller rotation (axial or radial
flow), or if the impeller type is used to mix highly viscous fluids. In total, the Mixer
Module Part Library includes eleven impellers: five axial impellers, four radial

impellers, and two impellers for highly viscous fluids.

AXIAL AND RADIAL IMPELLERS

Axial impellers give the flow an axial component naturally achieving mixing along the
z-axis of the mixer. This type of mixers is appropriate for fluids that are sensitive to high
shear rates. For example, fermentation processes have living cells in the reactor
solution, cells that would be killed by high shear rates. In these processes, axial

impellers are often selected and baftles are usually omitted.

Radial impellers force the flow in the radial direction and only give an axial component
once the flow hits the walls of the vessel. In order to achieve good mixing, these
impellers rely on high shear rates and the presence of baffles, that disrupts tangential

flows that would lead to poor mixing.

The figure below shows an example of an axial and a radial impeller.

Axial impeller Radial impeller

Figure 2-3: Examples of an axial impeller (pitched impeller) and a vadial impeller
(Rushton turbine).
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PITCHED BLADE IMPELLER

The most common axial impeller is the pitched blade impeller; see Figure 2-4 below.
This impeller can be configured for rectangular blades or for isosceles trapezoid-shaped
blades. These blade shapes can be created with wider outer or inner edges.

Attachment to Smaller inner  Larger outer
the impeller hub blade width blade width
Cut at the upper Cut at the upper

and inner edges and outer edges

Cut at the lower Cut at the lower
and outer edges and inner edges

Figure 2-4: Possible configuration of impeller bindes for symmetrical blades.

In addition to the symmetrical blades, asymmetrical blades can also be created. In
order to create asymmetrical blades, the upper part of the blade is made wider than the
lower part (see Figure 2-5). The impeller can then be flipped vertically to have the
wider part of the blade facing downward. The pitch angle of the impeller blades can
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be varied between 0 and 90 degrees. The outer vertices of the outer edges can also be
rounded using fillets.

Upper part of the blade
wider than lower part

/

‘ "Pitch angle

Figure 2-5: Asymmetrical blade. The upper part of the blade is wider than the lower part.

The figure below contains the notations used for the pitched impeller in the part
library. The full list of parameters together with their description is found in Table 2-1

I_ib*Ir_cl_ib

w ib*wr io ib w_ib*wr_io_ib*wr_col_ib

Figure 2-6: Notations used for the pitched impeller.

PITCHED IMPELLER WITH BENT BLADES

Bent blades may be used to decrease the pitch at the outer part (away from the hub)
of the impeller blade. Bending these parts gives a less aggressive pitch angle at the outer
edges. Using the Mixer Module, the bending is restricted to the upper and outer edges
of the impeller blades. The upper part can also be made wider than the lower part to
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obtain an asymmetrical blade. However, you can flip the impeller vertically to get a
bend or wider part that faces downward.

Attachment to Rectangular Asymmetric  Blade bend at the
the impeller hub  blade bend blade upper and outer edges

Cut at the lower Bend Cut at the upper
and outer edges angle and inner edges

Figure 2-7: Available blade bend and cut operations.

The vertices of the outer vertical edge can be rounded using fillets. The figure below
shows an impeller with asymmetrical blades and rounded vertices.

Cut upper and Fillets create
inner edges a rounded bend

Figure 2-8: Asymmetrical impeller blades with rounded outer (away from the hub)
Vertices.

IMPELLER PARTS |
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The figure below contains the notations used for the pitched impeller with bent blades
in the part library. The full list of parameters together with their description is found
in Table 2-1

w_ib*wr_io_ib

2
w_ib/2*wr_io_ib*(1-wr_col_ib)

Figure 2-9: Notations used for the pitched impeller with bent blades.

PITCHED BLADE IMPELLER WITH CONSTANT PITCH

For regular pitched impellers, the pitch increases with the radius of the impeller blades,
since the blade parts travel with increasing velocity with increasing radius. This means
that if the impeller rotated in a fluid, but was allowed to move freely in the axial
direction, the outer edge of a regular pitched impeller would want to travel at a higher
axial velocity than the inner edge. This effect subjects the impeller blade to a high
bending moment. The pitched impeller with constant pitch adapts the pitch angle with
the increasing radius so that the outer and inner edges get the same axial velocity as the

impeller rotates.

As for the regular pitched impellers, the pitched impeller with constant pitch can be
designed with isosceles trapezoid-shaped blade projections (the blades are not flat).
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The blades can also be cut in both upper and lower edges to achieve different impeller

configurations.
Attachment to “Twisted” Smaller inner  Larger outer
the impeller hub  rectangular blade blade width blade width

Cut upper and Cut upper and
inner edges outer edges

Cut lower and Cut lower and
outer edges inner edges

Figure 2-10: Pitched impellers with constant pitch with different blade shapes.

The inner pitch angle can be varied in order to change the axial and radial components
of the flow induced by the impeller. The pitch angle is then automatically calculated to
give a constant pitch.

IMPELLER PARTS |
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The outer vertices of the blades can be rounded, which gives additional freedom in the
design of the impeller blades. The figure below shows a propeller created by using
fillets and cuts and applying those on a pitched impeller with constant pitch.

__ Fillet on upper
and outer vertex

Fillet on lower
and outer vertex

Large fillet radius
yields a propeller shape

Figure 2-11: Impeller of propeller type created using isosceles trapezoid-shaped binde
projections and large fillet radii for the outer vertices of the blades.

The figure below contains the notations used for the pitched impeller with constant
pitch in the part library. The full list of parameters together with their description is
found in Table 2-1

A (ap_ib-aa_ib) o
\%’ Lib
2

w_ib*wr_io_ib*wr_col_ib

I_ib*Ir_cl_ib
w_ib*wr_io_ib

Figure 2-12: Notations used for the pitched impeller with constant pitch.

HYDROFOIL IMPELLER

Impellers with blades that are curved along the vertical edges are denoted hydrofoil
impellers. These impellers are similar to the pitched blade impellers, but give an
additional pressure difference across the impeller blade with an additionally lowered

pressure on the convex side of the blade.
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In addition to varying the curvature radius of the blades, the shape of the impeller
blade projections can be varied to get the same freedom in the design of hydrofoil
impellers as for the case of the pitched impeller mentioned above. This implies that
isosceles trapezoid-shaped blade projections, asymmetrical blades with a wider upper
part, and cut blades can be used to create the desired design. Fillets make it possible to

create impellers of propeller type.

As in the case for the pitched impeller type, the pitch angle can be varied to control the

relation between the radial and axial flow created as the impeller rotates.

Rectangular curved Asymmetrical blade with wider
blade with attachment at the hub upper part of the blade

Cut upper and
inner edges

blades

, Flip
horizontal

Flip
vertical

Cut lower and

Large fillet
radius outer edges

Figure 2-13: The curved blades can be shaped to create a lavge variety of impeller designs.
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The figure below contains the notations used for the hydrofoil impeller in the part
library. The full list of parameters together with their description is found in Table 2-1

I_ib*(1-Ir_cl_ib}

T S N

w_ib/2 j‘jb

w_ib/2*wr_io_ib

re_v_ib*wr_io_ib

Figure 2-14: Notations used for the hydrofoil impeller.

HYDROFOIL IMPELLER WITH CONSTANT PITCH

In the same fashion as for the pitched impeller, the hydrofoil impeller creates an axial
flow velocity that increases with the impeller radius as the impeller rotates. This effect
subjects the impeller blade to a bending moment. A hydrofoil impeller with constant
pitch adapts the pitch angle in order to obtain an almost constant pitch of the
projection of the curved blade along the radius of the impeller blades. Note that it is
not possible (at least not easy) to obtain an exactly constant pitch with increasing radius
for the hydrofoil impeller since the blades are curved.

As in the case for the regular hydrofoil impellers, the hydrofoil impeller with constant
pitch gives an additional pressure difference across the impeller blade with an

additionally lowered pressure on the convex side of the blade.
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The impeller blade can be designed with cut blades and asymmetrical blades. Fillets can
be used to obtain impellers of propeller type.

Rectangular curved Cut upper and Cut lower and
and twisted blade inner edges outer edges

Cut wider
outer edge

Large fillet Cut lower and
radius outer edges with fillets

Figure 2-15: Hydrofoil impellers with constant pitch.

The figure below contains the notations used for the hydrofoil with constant pitch
impeller in the part library. The full list of parameters together with their description
is found in Table 2-1

I_ib*(1-Ir_cl_ib}

d_hu

re_v_ib*wr_io_ib

ap_ib-aa_ib

Figure 2-16: Notations used for the hydrofoil with constant pitch.

THE C-SHAPED DOUBLE BLADE IMPELLER
This is an axial impeller that is suitable for fluids with relatively high viscosity. It consists
of two pitched blades equipped with a c-shaped double-blade part that adds shear at
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the outer radius of the impeller. This impeller can be used to create the so-called

Intermig® impeller.

The impeller can be designed with different pitch angles on the arms of the impeller.
Also the angles of the c-shaped part can be varied. The profile can be changed by
changing the vertical angle of the c-shaped part but keeping the upper and lower

7t}
C

blades parallel. In addition, also the angle of the back of the can be varied, keeping
the lower and upper blades parallel but displacing them in the xy-plane.

C-shaped Adapt for clockwise
double blade

Impeller arm

Varying angle of
_c-shaped profile

N

Figure 2-17: The c-shaped with double blades impeller.
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The figure below contains the notations used for the c-shaped double blade impeller
in the part library. The full list of parameters together with their description is found
in Table 2-1

d_hu d_im/2

lt/@i* _ H—é

Figure 2-18: Notations used for the c-shaped donble blade impeller.

RUSHTON TURBINE

Axial impellers, such as the Rushton turbine, work by pumping the fluid toward the
walls of the vessel and then let the collision of the fluid with the wall supply the axial
mixing and the turbulence required for mixing. In order to avoid a tangential flows
that would result in a poor mixing, baffles are often used in combination with Rushton
turbines. Rushton turbines induce a relatively high shear rate and therefore appropriate
in processes where the fluid is not sensitive to shear rates.

The turbine can be designed with different blade lengths and also with different disk

diameters.

Impeller blade

Impeller disk

Figure 2-19: The Rushton turbine.
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The figure below contains the notations used for the Rushton turbine in the part

library. The full list of parameters together with their description is found in Table 2-1

Figure 2-20: Notations used for the Rushton turbine.

THE RUSHTON TURBINE WITH BACKSWEPT BLADES

This type of impeller is similar to the Rushton turbine. The backswept blades allow for
a smoother operation with lower shear rates. It is possible to vary the blade length, the
disk diameter, as well as the curvature and blade angle relative to the perimeter of the
disk.

Impeller blade

Direction of
rotation

Impeller disk

Figure 2-21: The Rushton turbine with backswept blades.
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The figure below contains the notations used for the Rushton turbine with backswept
blades in the part library. The full list of parameters together with their description is
found in Table 2-1

Figure 2-22: Notations used for the Rushton turbine with backswept blades.

THE SMITH TURBINE

This is also an impeller that resembles the Rushton turbine. It has the same properties
as the Rushton turbine but with a somewhat smoother operation with lower shear
rates. The length of the blades, the diameter of the disk, as well as the radius of the
curvature of the blades can be varied when creating the impeller geometry.

Impeller blade

Direction of
rotation Impeller disk

Figure 2-23: The Smith turbine.
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The figure below contains the notations used for the Smith turbine in the part library.
The full list of parameters together with their description is found in Table 2-1

Figure 2-24: Notations used for the Smith turbine.

THE BACKSWEPT BLADE IMPELLER

This impeller type is suitable for fluids with low viscosity and density (for example,
gases). The curvature of the blades create smooth operating conditions with relatively
small shear rates compared to straight blades. The impeller can be designed with

different blade lengths and curvatures of the blades.

Curvature ™\
~._radius ]

Impeller
blade

N
Direction of ™
rotation

Attachment to the hub

Figure 2-25: The backswept impeller.
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The figure below contains the notations used for the backswept blade impeller in the
part library. The full list of parameters together with their description is found in
Table 2-1

Figure 2-26: Notations used for the backswept blade impeller.

ANCHOR IMPELLER

This impeller type is suitable for mixing fluids of very high viscosity. For example, this
impeller is common when mixing Portland concrete and paints in small scales.The
lower part of the impeller is shaped as an ellipse that is cut in the middle. The major
axis of the ellipse equals the impeller diameter while the minor axis equals to the dished
tank where the impeller is placed minus the clearance between the impeller and tank

wall.

Upper hub

Figure 2-27: Anchor impeller.
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The figure below contains the notations used for the anchor impeller in the part library.

The full list of parameters together with their description is found in Table 2-1

d_is [|
. | |

rma_an_i[n-w_ib

o P rmi_an_im-w_ib

Figure 2-28: Notations used for the anchor impeller.

Impeller Parameters

The table below contains the names and descriptions of the input parameter used for

the impellers in the Mixer Module Part Library.

TABLE 2-1: MIXER MODULE PART LIBRARY PARAMETERS
ab_ib Bending angle of folded section
ac_h_s ib  Shear angle, back of c-shape blades
ac_ib Vertical angle between arm and c-shaped blade
ac_s_ib Internal angle, c-shaped profile
ap_ib Pitch angle of impeller blade
ar_ib Rake angle of impeller
as_ib Relative rotation angle around shaft
d_a_ib Diameter of attachment section
d_hu Impeller hub diameter
d_id Diameter of impeller dish
d_im Impeller diameter
d_is Impeller shaft diameter
d_ta Tank diameter
Da d_im Input diameter for turbulence model
db_im Distance of first impeller hub from bottom
dc_ib Blade width, c-shaped blades
h_an_im Height of anchor impeller
hp_im Impeller position
CHAPTER 2: MIXER MODULE PART LIBRARY



TABLE 2-1: MIXER MODULE PART LIBRARY PARAMETERS

hp_is
1_ib
lc_ib
1r_bu_ib

1r_cl_ib

1r_cu_ib

n_ib

pa_rd_im

pa_ud_im

rc_h_ib

rc_v_ib
rf_ib
w_a_ib
w_bou_ib
w_cil_ib
w_ciu_ib
w_col_ib
w_cou_ib
w_ib
w_o_ib
wc_ib
wc_o_ib
wr_ai_ib

wr_asu_ib

Position of the lowest part of the impeller shaft
Length of the impeller blades, Rushton, Smith
Blade length, c-shaped blades

Relative position of the bending point along the length of

the upper edge of the impeller blade

Relative position of cutting point along the length of the
lower edge

Relative position of cutting point along the length of the
upper edge

Number of blades

Parameter that controls the impeller blade direction:

1 = clockwise and -1 = counterclockwise

Flip impeller vertically

Curvature of backswept Rushton, Smith, and Backswept

impeller

Hydrofoil curvature radius closest to the hub

Fillet radius of outer vertices

Blade
Width
Width
width
Width
width

attachment width

of
of
of
of
of

Impeller

Outer
Blade
OQuter

Ratio

Asymmetry factor for upper part of the width of the

impeller blade: wider upper part

the folded section at the outer edge

inner
inner
outer
outer
blade

impeller

distance, c-shaped blades
arm width for c-shaped impeller
between blade width and blade attachment

and lower
and upper
and lower
and upper
width
width

1 = symmetry,

cut
cut
cut
cut
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Mixer Module Theory

In this chapter:

* Theory for the Free Surface Features
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Theory for the Free Surface Features

In this section:

¢ Deforming Domain

e Free Surface Conditions

* Contact Angle

¢ Rotating Shaft Conditions

e References for the Free Surface Features

Theory for the Rotating Machinery Interfaces and Theory for the
@l Nonisothermal Flow and Conjugate Heat Transfer Interfaces in the CFD
Module User’s Guide.

The links to the physics features described in other guides do not work in
n the PDEF, only from the online help in COMSOL Multiphysics.

CHAPTER 3:

Deforming Domain

The mesh within the free surface domain is deformed to account for the movement of
the free surface. This mesh movement is accomplished using a moving mesh approach.
The software perturbs the mesh nodes so that they conform with the free surface and
with other moving or stationary boundaries in the model. The boundary displacement
is propagated throughout the domain to obtain a smooth mesh deformation
everywhere. This is done by solving PDEs for the mesh displacements, using the
movement of the free surface as boundary condition. Taking two dimensions as an
example, a location in the deformed mesh with coordinates (x, y) can be related to its

coordinates in the original undeformed mesh (X,Y) by a function on the form:
x =x(X,Y, 1), y =yXY,¢)

The original, undeformed, mesh is referred to as the material frame (or reference
frame), while the deformed mesh is called the spatial frame. COMSOL Multiphysics
also defines geometry and mesh frames, which are coincident with the material frame
for this physics interface.
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For the Rotating Machinery interfaces the fluid-flow equations (along with other
coupled equations such as heat or chemical species transport) are solved in the spatial

frame in which the mesh is perturbed.

A number of mesh smoothing methods are available: Yeoh (the default), Laplace,
Winslow, and Hyperelastic. Note that the equations used for each smoothing type have
different properties.

Deformed Geometry and Moving Mesh in the COMSOL Multiphysics
Q@ Reference Manual

Free Surface Conditions

The Free Surface feature assumes that the density and viscosity of the fluid outside the
domain are negligible compared to the corresponding values inside the domain. On

the free surface the following condition for the stress, T, along the surface is applied:

n; - t=-pemn+f=-pn+o(Vy-mn)n,-Vo (3-1)

Here pgy is the pressure outside the free surface domain (ST unit: Pa) and fy; denotes
the surface tension forces (SI unit: N/ m2). In the surface tension terms, V is the
surface gradient operator (Vy= (I -n; niT)V where I is the identity matrix) and o is
the surface tension coefficient (SI unit: N/m).

The mesh velocity at the free surface is defined as the fluid velocity in the direction

normal to the surface:

(umcsh ‘n) = (u-n) (3-2)

Contact Angle

At a three-phase boundary, it is necessary to add force terms to ensure that the fluid
maintains a consistent contact angle. The forces acting at the contact point are applied
to the fluid by the Contact Angle node (added per default under a Free Surface node).
In equilibrium, the surface tension forces and the normal restoring force from the
surface are in balance at a contact angle (6,), as shown in Figure 3-1. This equilibrium
is expressed by Young's equation, which considers the components of the forces in the

plane of the surface:

6c0s(0,) + Y51 = Yeo (3-3)
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where o is the surface tension between the two fluids, ,1 is the surface energy density
on the wetted side, and Y,9 the surface energy density on the other side of the

two-phase interface.

o
Fluid 2 Fluid 1

Figure 3-1: The forces acting at a contact point. In equilibrium, the surface tension forces
and the normal vestoring force from the surface are in balance at a contact angle 0.

There is still debate in the literature as to precisely what occurs in non-equilibrium
situations (for example, drop impact) when the physical contact angle deviates from
the contact angle specified by Young’s equation. A simple approach, is to assume that
the unbalanced part of the in-plane Young force acts on the fluid to move the contact
angle toward its equilibrium value (Ref. 1). COMSOL Multiphysics employs this
approach as it is physically motivated and is consistent with the thermodynamics
allowed form of the boundary condition (Ref. 2, Ref. 3).

The normal force balance at the solid surface is handled by the wall boundary
condition, which automatically prevents fluid flow across the solid boundary through
a no-penetration condition. The wall fluid interface feature applies a force, f,,¢ on the
fluid at the interface:

fwf = 6(cos(0,) — cos(0))m,

where 6 is the actual contact angle and my is the binormal to the solid surface.

Rotating Shaft Conditions

Using a Rotating Shaft feature, the velocity of the shaft boundary is defined by
assuming solid body rotation of the shaft. The wall velocity is hence a function of the

angular velocity w (ST unit: rad/s) of the shaft, and the (spatial frame) position x:

_ rax
w, = W X (X-Ty) (3-4)
vl
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where 1y and 1y, is the rotation axis direction and rotation base point, respectively.

References for the Free Surface Features

1.J. Gerbeau and T. Lelievre, “Generalized Navier Boundary Condition and
Geometric Conservation Law for Surface Tension,” Computer Methods In Applied
Mechanics and Engineering, vol. 198, pp. 644-656, 2009.

2. W. Ren and E. Weinan, “Boundary Conditions for the Moving Contact Line
Problem,” Physics of Fluids, vol. 19, p. 022101, 2007.

3. W.Ren and D. Hu, “Continuum Models for the Contact Line Problem,” Physics of
Fluids, vol. 22, p. 102103, 2010.
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Rotating Machinery, Fluid Flow

The Rotating Machinery, Laminar Flow (spf) and Rotating Machinery, Turbulent Flow
(spf) interfaces, found under the Single-Phase Flow>Rotating Machinery branch

when adding a physics interface, are used for modeling flow where one or more of

the boundaries rotate in a periodic fashion. This is used for mixers and propellers.

The physics interfaces support compressible, weakly compressible and
incompressible flow, the flow of non-Newtonian fluids described by the Power Law,
Carreau, Bingham-Papanastasiou, Herschel-Bulkley-Papanastasiou, and
Casson-Papanastasiou models, as well as turbulent flow. In addition, the physics
interfaces support creeping flow, although the shallow channel approximation is

redundant.

In this chapter:

* Moving Mesh

¢ The Rotating Machinery, Laminar Flow Interface

¢ The Rotating Machinery, Turbulent Flow, Algebraic yPlus Interface
e The Rotating Machinery, Turbulent Flow, L-VEL Interface

¢ The Rotating Machinery, Turbulent Flow, k-¢ Interface

¢ The Rotating Machinery, Turbulent Flow, Realizable k-¢ Interface
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* The Rotating Machinery, Turbulent Flow, k-o Interface

e The Rotating Machinery, Turbulent Flow, SST Interface

¢ The Rotating Machinery, Turbulent Flow, Low Re k-¢ Interface

¢ The Rotating Machinery, Turbulent Flow, Spalart-Allmaras Interface
e The Rotating Machinery, Turbulent Flow, v2-f Interface

* Domain, Boundary, Point, and Pair Nodes for the Rotating Machinery Interfaces
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The Rotating Machinery, Fluid Flow
Interfaces

Moving Mesh

The Rotating Machinery, Fluid Flow interfaces rely on ALE (arbitrary
Lagrangian-Eulerian) moving mesh functionality for their rotating domain and free

surface implementation.

ROTATING DOMAINS

When a Rotating Machinery, Fluid Flow interface is added using the Model Wizard, a
Rotating Domain node is added automatically in the Model Builder under the
Definitions>Moving Mesh node. It contains settings for specifying the rotation of one or
several domains. By default, All domains are sclected. Under the Rotating Domain, you
can exclude any non-rotating fluid domains. For both 3D and 2D components, the

Rotation type should be set to Specified rotational velocity.

Select a Rotational velocity expression — General revolutions per time (the default),

Constant revolutions per time, General angular velocity, or Constant angular velocity.

¢ For Constant revolutions per time, or General revolutions per time, cnter a value or
expression respectively in the Revolutions per time input field and optionally an Initial

angle. The angular velocity in this case is defined as the input multiplied by 2.

* For Constant angular velocity, or General angular velocity enter a value or an
expression respectively in the Angular velocity input field and optionally an Initial

angle.

3D Components

For 3D components, select the Rotation axis base point, r . The default is the origin.
Select the Rotation axis, u,;, the z-axis is the default. If the x-axis is selected, it
corresponds to a rotational axis (1, 0, 0) with the origin as the base point, and

correspondingly for the y-axis and z-axis.

2D Components
For 2D components, enter coordinates for the Rotation axis base point, r,.. The
default is the origin (0, 0).

THE ROTATING MACHINERY, FLUID FLOW INTERFACES
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DEFORMING DOMAIN

When using the Free Surface feature, a Deforming Domain must first be added in the
Model Builder under the Definitions>Moving Mesh node. Within the Deforming Domain,
the mesh position is solved for to match the current position of the free surface. On
external boundaries not defined as a free surface, the mesh is constrained to move only
in the tangential direction. On boundaries which are internal with respect to the fluid
(separating deforming domains from ordinary fluid domains), the mesh is constrained

to its initial position.

If there is more than one deforming domain, these must not intersect. Also a

deforming domain cannot intersect with a rotating domain.

Mesh Smoothing Type

This setting controls the method used to solve for the mesh displacement within
deforming domains. The Mesh smoothing type can be chosen to be Laplace, Winslow,
Hyperelastic, or Yeoh (the default) smoothing. Note that the equations used for each
smoothing type have different properties. For the Yeoh mesh smoothing type, also
specify a Stiffening factor (default: 10). See Smoothing Methods in the COMSOL

Multiphysics Reference Manual for more information.

'El. Free Surface

The Rotating Machinery, Laminar Flow Interface

The Rotating Machinery, Laminar Flow (spf) interface (== ), found under the

Single-Phase Flow>Rotating Machinery branch (=i=), is used to simulate flow at low to
moderate Reynolds numbers in geometries with one or more rotating parts. The
physics interface supports incompressible, weakly compressible and compressible flows
at low Mach numbers (typically less than 0.3). It also supports modeling of

non-Newtonian fluids. The physics interface is available for 3D and 2D components.

There are two study types available for this physics interface. Using the Time Dependent
study type, rotation is achieved through moving mesh functionality, also known as
sliding mesh. Using the Frozen Rotor study type, the rotating parts are kept frozen in
position, and rotation is accounted for by the inclusion of centrifugal and Coriolis
forces. In both types, the momentum balance is governed by the Navier-Stokes
equations, and the mass conservation is governed by the continuity equation. See
Theory for the Rotating Machinery Interfaces in the CFD Module User’s Guide.
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When this physics interface is added, the following default physics nodes are also added
in the Model Builder under Laminar Flow — Fluid Properties, Wall and Initial Values. A
Moving Mesh interface with a Retating Domain node is added automatically in the Model
Builder under the Definitions node. Then, from the Physics toolbar, add other nodes
that implement, for example, boundary conditions and volume forces. You can also
right-click Laminar Flow to select physics features from the context menu. See Domain,
Boundary, Pair, and Point Nodes for Single-Phase Flow in the CFD Module User’s
Guide.

Pseudo Time Stepping for Laminar Flow Models in the CED Module
.& User’s Guide

Laminar Flow in a Baffled Stivred Mixer: Application Library path
I]I[l CFD_Module/Fluid-Structure_Interaction/baffled_mixer

SETTINGS
The Label is the default physics interface name.

The Name is used primarily as a scope prefix for variables defined by the physics
interface. Refer to such physics interface variables in expressions using the pattern
<name>.<variable_name>. In order to distinguish between variables belonging to
different physics interfaces, the name string must be unique. Only letters, numbers, and

underscores (_) are permitted in the Name field. The first character must be a letter.
The default Name (for the first physics interface in the model) is spf.

In addition to the settings described below, see The Creeping Flow, Laminar Flow,
Turbulent Flow, and Large Eddy Simulation Interfaces in the CFD Module User’s
Guide for all the other settings available. See Domain, Boundary, Point, and Pair

Nodes for the Rotating Machinery Interfaces for links to all the physics nodes.

ADVANCED SETTINGS

To display this section, click the Show More Options button ("= ) and select Advanced
Physics Options in the Show More Options dialog box. Normally these settings do not
need to be changed.

Pseudo Time Stepping
Select the Use pseudo time stepping for stationary equation form check box to add

pseudo time derivatives to the equation when the Frozen Rotor equation form is used.
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(Frozen rotor is a pseudo stationary formulation.) When selected, also choose a CFL
number expression — Automatic (the default) or Manual. Automatic sets the local CFL
number (from the Courant—Friedrichs—Lewy condition) to the built-in variable
CFLCMP which in turn triggers a PID regulator for the CFL number. For Manual enter
a Local CFL number CFLy,. (dimensionless).

The Rotating Machinery, Turbulent Flow, Algebraic yPlus Interface

The Rotating Machinery, Turbulent Flow, Algebraic yPlus (spf) interface (12 ), found

under the Single-Phase Flow>Rotating Machinery branch (==) when adding a physics
interface, is used to simulate flow at high Reynolds numbers in geometries with one or
more rotating parts. The physics interface is suitable for incompressible, weakly

compressible and compressible flows at low Mach numbers (typically less than 0.3).

The equations solved by the Turbulent Flow, Algebraic yPlus interface are the
Reynolds-averaged Navier-Stokes (RANS) equations for conservation of momentum,
the continuity equation for conservation of mass, and an algebraic equation for the
scaled wall distance. Turbulence effects are included using an enhanced viscosity model
based on the scaled wall distance, and the physics interface therefore includes a wall

distance equation.

Two study types are available for this physics interface. Using the Time Dependent with
Initialization study type, the rotation is achieved through moving mesh functionality,
also known as sliding mesh. Using the Frozen Rotor with Initialization study type, the
rotating parts are kept frozen in position, and the rotation is accounted for by the
inclusion of centrifugal and Coriolis forces. Both study types includes an initial Wall
Distance Initialization step in order to compute the wall distance. See Theory for the
Rotating Machinery Interfaces in the CFD Module User’s Guide.

When this physics interface is added, the following physics nodes are also added in the
Model Builder under Turbulent Flow, Algebraic yPlus — Fluid Properties, Wall and Initial
Values. A Moving Mesh interface with a Rotating Domain node is added automatically in
the Model Builder under the Definitions node. Then, from the Physics toolbar, add other
nodes that implement, for example, boundary conditions and volume forces. You can
also right-click Turbulent Flow, Algebraic yPlus to select physics features from the
context menu. For information about the available physics features, see Domain,

Boundary, Point, and Pair Nodes for the Rotating Machinery Interfaces.
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A part for the settings below, see the advanced settings for The Rotating Machinery,
Laminar Flow Interface, and The Creeping Flow, Laminar Flow, Turbulent Flow, and
Large Eddy Simulation Interfaces in the CFD Module User’s Guide.

TURBULENCE MODEL PARAMETERS
The turbulence model parameters for the Algebraic yPlus model, x, and B, have been
optimized for turbulent pipe flow. For certain cases, better performance can be

obtained by tuning the model parameters.

DEPENDENT VARIABLES

The following dependent variables (fields) are defined for this physics interface:
¢ Velocity field u

* Pressure p

* Reciprocal wall distance G

* Wall distance in viscous units yPlus (dimensionless)

The Rotating Machinery, Turbulent Flow, L-VEL Interfuce

The Rotating Machinery, Turbulent Flow, L-VEL (spf) interface (lé ), found under the

Single-Phase Flow>Rotating Machinery branch (== ) when adding a physics interface, is
used to simulate flow at high Reynolds numbers in geometries with one or more
rotating parts. The physics interface is suitable for incompressible, weakly compressible

and compressible flows at low Mach numbers (typically less than 0.3).

The equations solved by the Turbulent Flow, L-VEL interface are the
Reynolds-averaged Navier-Stokes (RANS) equations for conservation of momentum,
the continuity equation for conservation of mass, and an algebraic equation for the
scaled fluid flow velocity tangential to the nearest wall. Turbulence effects are included
using an enhanced viscosity model based on the scaled wall distance, and the physics

interface therefore includes a wall distance equation.

Two study types available for this physics interface. Using the Time Dependent with
Initialization study type, the rotation is achieved through moving mesh functionality,
also known as sliding mesh. Using the Frozen Rotor with Initialization study type, the
rotating parts are kept frozen in position, and the rotation is accounted for by the
inclusion of centrifugal and Coriolis forces. Both study types includes an initial Wall
Distance Initialization step in order to compute the wall distance. See Theory for the
Rotating Machinery Interfaces in the CFD Module User’s Guide.
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When this physics interface is added, the following physics nodes are also added in the
Model Builder under Turbulent Flow, L-VEL — Fluid Properties, Wall, and Initial Values. A
Moving Mesh interface with a Retating Domain node is added automatically in the Model
Builder under the Definitions node. Then, from the Physics toolbar, add other nodes
that implement, for example, boundary conditions and volume forces. You can also
right-click Turbulent Flow, L-VEL to select physics features from the context menu. For
information about the available physics features, see Domain, Boundary, Point, and

Pair Nodes for the Rotating Machinery Interfaces.

A part for the interface settings defined below, see the advanced settings for The
Rotating Machinery, Laminar Flow Interface, and the settings in The Creeping Flow,
Laminar Flow, Turbulent Flow, and Large Eddy Simulation Interfaces in the CFD
Module User’s Guide.

TURBULENCE MODEL PARAMETERS
The turbulence model parameters for the L-VEL model, x; and E;, have been
optimized for internal flow. For certain cases, better performance can be obtained by

tuning the model parameters.

DEPENDENT VARIABLES
The following dependent variables (fields) are defined for this physics interface:
¢ Velocity field u

* Pressure p

* Reciprocal wall distance G

¢ Tangential velocity in viscous units uPlus (dimensionless)

The Rotating Machinery, Turbulent Flow, k-€ Interfuce

The Rotating Machinery, Turbulent Flow, k-€ (spf) interface (12 ), found under the

Single-Phase Flow>Rotating Machinery branch (=}=) when adding a physics interface, is

used to simulate flow at high Reynolds numbers in geometries with one or more
rotating parts. The physics interface is suitable for incompressible, weakly compressible

and compressible flows at low Mach numbers (typically less than 0.3).

The momentum balance is governed by the Navier-Stokes equations, and the mass
conservation is governed by the continuity equation. Turbulence effects are modeled
using the standard two-equation £-&€ model with realizability constraints. Flow close to

walls is modeled using wall functions.
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There are two study types available for this physics interface. Using the Time Dependent
study type, the rotation is achieved through moving mesh functionality, also known as
sliding mesh. Using the Frozen Rotor study type, the rotating parts are kept frozen in
position, and the rotation is accounted for by the inclusion of centrifugal and Coriolis
forces. See Theory for the Rotating Machinery Interfaces in the CED Module User’s
Guide.

When this physics interface is added, the following physics nodes are also added in the
Model Builder under Turbulent Flow, k-¢ — Fluid Properties, Wall and Initial Values. A
Moving Mesh interface with a Retating Domain node is added automatically in the Model
Builder under the Definitions node. Then, from the Physics toolbar, add other nodes
that implement, for example, boundary conditions and volume forces. You can also
right-click Turbulent Flow, k- to select physics features from the context menu. For
information about the available physics features, see Domain, Boundary, Point, and

Pair Nodes for the Rotating Machinery Interfaces.

A part for the defined settings below, see the advanced settings for The Rotating
Machinery, Laminar Flow Interface, and the settings in The Creeping Flow, Laminar
Flow, Turbulent Flow, and Large Eddy Simulation Interfaces in the CFD Module
User’s Guide.

TURBULENCE MODEL PARAMETERS
Turbulence model parameters are optimized to fit as many flow types as possible, but
for some special cases, better performance can be obtained by tuning the model

parameters.

For this physics interface the parameters are C,1, Ceg, Cy, 0, 6, &, and B.
DEPENDENT VARIABLES

The following dependent variables (fields) are defined for this physics interface:

* Velocity field u and its components
* Pressure p
* Turbulent kinetic energy %

¢ Turbulent dissipation rate ep

The Rotating Machinery, Turbulent Flow, Realizable k-€ Interface

The Rotating Machinery, Turbulent Flow, Realizable k- (spf) interface (=

under the Single-Phase Flow>Rotating Machinery branch (=) when adding a physics
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interface, is used to simulate flow at high Reynolds numbers in geometries with one or
more rotating parts. The physics interface is suitable for incompressible, weakly

compressible and compressible flows at low Mach numbers (typically less than 0.3).

The momentum balance is governed by the Navier-Stokes equations, and the mass
conservation is governed by the continuity equation. Turbulence effects are modeled
using the Realizable two-equation k-& model. Flow close to walls is modeled using wall

functions.

There are two study types available for this physics interface. Using the Time Dependent
study type, the rotation is achieved through moving mesh functionality, also known as
sliding mesh. Using the Frozen Rotor study type, the rotating parts are kept frozen in
position, and the rotation is accounted for by the inclusion of centrifugal and Coriolis
forces. See Theory for the Rotating Machinery Interfaces in the CED Module User’s
Guide.

When this physics interface is added, the following physics nodes are also added in the
Model Builder under Turbulent Flow, Realizable k-€ — Fluid Properties, Wall and Initial

Values. A Moving Mesh interface with a Rotating Domain node is added automatically in
the Model Builder under the Definitions node. Then, from the Physics toolbar, add other
nodes that implement, for example, boundary conditions and volume forces. You can
also right-click Turbulent Flow, Realizable k-¢ to select physics features from the context
menu. For information about the available physics features, see Domain, Boundary,

Point, and Pair Nodes for the Rotating Machinery Interfaces.

A part for the defined settings below, see the advanced settings for The Rotating
Machinery, Laminar Flow Interface, and the settings in The Creeping Flow, Laminar
Flow, Turbulent Flow, and Large Eddy Simulation Interfaces in the CFD Module
User’s Guide.

TURBULENCE MODEL PARAMETERS
Turbulence model parameters are optimized to fit as many flow types as possible, but
for some special cases, better performance can be obtained by tuning the model

parameters.

For this physics interface the parameters are Cy, A, O, G,, &, and B.
DEPENDENT VARIABLES

The following dependent variables (fields) are defined for this physics interface:

* Velocity field u and its components

* Pressure p
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¢ Turbulent kinetic energy %

* Turbulent dissipation rate ep

The Rotating Machinery, Turbulent Flow, k- Interface

The Rotating Machinery, Turbulent Flow, k-0 (spf) interface (Jé ), found under the

Single-Phase Flow>Rotating Machinery branch (=) when adding a physics interface, is
used to simulate flow at high Reynolds numbers in geometries with one or more

rotating parts. The physics interface supports incompressible, weakly compressible and
compressible flows at low Mach numbers (typically less than 0.3). The physics interface

is available for 3D and 2D components.

The momentum balance is governed by the Navier-Stokes equations, and the mass
conservation is governed by the continuity equation. Turbulence effects are modeled
using Wilcox revised two-equation k-® model with realizability constraints. Flow close

to walls is modeled using wall functions.

There are two study types available for this physics interface. Using the Time Dependent
study type, the rotation is achieved through moving mesh functionality, also known as
sliding mesh. Using the Frozen Rotor study type, the rotating parts are kept frozen in
position, and the rotation is accounted for by the inclusion of centrifugal and Coriolis
forces. See Theory for the Rotating Machinery Interfaces in the CED Module User’s
Guide.

When this physics interface is added, the following physics nodes are also added in the
Model Builder under Turbulent Flow, k- — Fluid Properties, Wall and Initial Values. A
Moving Mesh interface with a Retating Domain node is added automatically in the Model
Builder under the Definitions node. Then, from the Physics toolbar, add other nodes
that implement, for example, boundary conditions and volume forces. You can also
right-click Turbulent Flow, k-0 to select physics features from the context menu. For
information about the available physics features, see Domain, Boundary, Point, and

Pair Nodes for the Rotating Machinery Interfaces.

A part for the settings defined below, see the advanced settings for The Rotating
Machinery, Laminar Flow Interface, and the settings in The Creeping Flow, Laminar
Flow, Turbulent Flow, and Large Eddy Simulation Interfaces in the CFD Module
User’s Guide.
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TURBULENCE MODEL PARAMETERS
Turbulence model parameters are optimized to fit as many flow types as possible, but
for some special cases, better performance can be obtained by tuning the model

parameters.

For this physics interface the parameters are @, 0", Gy, Bo, Bo"» Ky, and B.

DEPENDENT VARIABLES
The following dependent variables (fields) are defined for this physics interface:

* Velocity field u and its components
* Pressure p
¢ Turbulent kinetic energy %

¢ Specific dissipation rate om

The Rotating Machinery, Turbulent Flow, SST Interface

The Rotating Machinery, Turbulent Flow, SST (spf) interface ( JZ ), found under the

Single-Phase Flow>Rotating Machinery branch (=:=) when adding a physics interface, is
used to simulate flow at high Reynolds numbers in geometries with one or more

rotating parts. The physics interface supports incompressible, weakly compressible and
compressible flows at low Mach numbers (typically less than 0.3). The physics interface

is available for 3D and 2D components.

The momentum balance is governed by the Navier-Stokes equations, and the mass
conservation is governed by the continuity equation. Turbulence effects are modeled
using the SST two-equation model with realizability constraints. The SST model is a
so-called low-Reynolds number model, which means that it resolves the flow all the
way down to the wall. The SST model depends on the distance to the closest wall. The

physics interface therefore includes a wall distance equation.

There are two study types available for this physics interface. Using the Time Dependent
with Initialization study type, the rotation is achieved through moving mesh
functionality, also known as sliding mesh. Using the Frozen Rotor with Initialization
study type, the rotating parts are kept frozen in position, and the rotation is accounted
for by the inclusion of centrifugal and Coriolis forces. See Theory for the Rotating
Machinery Interfaces in the CED Module User’s Guide. In both study types

initialization is performed by first solving for the distance to the closest wall.

When this physics interface is added, the following physics nodes are also added in the
Model Builder under Turbulent Flow, SST — Fluid Properties, Wall and Initial Values. A
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Moving Mesh interface with a Retating Domain node is added automatically in the Model
Builder under the Definitions node. Then, from the Physics toolbar, add other nodes
that implement, for example, boundary conditions and volume forces. You can also
right-click Turbulent Flow, SST to select physics features from the context menu. For
information about the available physics features, see Domain, Boundary, Point, and

Pair Nodes for the Rotating Machinery Interfaces.

A part for the interface settings defined below, see the advanced settings for The
Rotating Machinery, Laminar Flow Interface, and the settings in The Creeping Flow,
Laminar Flow, Turbulent Flow, and Large Eddy Simulation Interfaces in the CFD
Module User’s Guide.

TURBULENCE MODEL PARAMETERS

Turbulence model parameters are optimized to fit as many flow types as possible, but
for some special cases, better performance can be obtained by tuning the model
parameters. For this physics interface the parameters are a1, 4", B, Bo, 1, % Gk1> Okas
Op1,and oy9.

DEPENDENT VARIABLES

The following dependent variables (fields) are defined for this physics interface:
* Velocity field u and its components

* Pressure p

¢ Turbulent kinetic energy %

¢ Specific dissipation rate om

* Reciprocal wall distance G

The Rotating Machinery, Turbulent Flow, Low Re k-€ Interface

The Rotating Machinery, Turbulent Flow, Low Re k-¢ (spf) interface ( lé ), found under

the Single-Phase Flow>Rotating Machinery branch (== ) when adding a physics interface,
is used to simulate flow at high Reynolds numbers in geometries with one or more

rotating parts. The physics interface supports incompressible, weakly compressible and
compressible flows at low Mach numbers (typically less than 0.3). The physics interface

is available for 3D and 2D components.

The momentum balance is governed by the Navier-Stokes equations, and the mass
conservation is governed by the continuity equation. Turbulence effects are modeled
using the AKN two-equation k-& model with realizability constraints. The AKN model
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is a so-called low-Reynolds number model, which means that it resolves the flow all the
way down to the wall. The AKN model depends on the distance to the closest wall.

The physics interface therefore includes a wall distance equation.

There are two study types available for this physics interface. Using the Time Dependent
with Initialization study type, the rotation is achieved through moving mesh
functionality, also known as sliding mesh. Using the Frozen Rotor with Initialization
study type, the rotating parts are kept frozen in position, and the rotation is accounted
for by the inclusion of centrifugal and Coriolis forces. See Theory for the Rotating
Machinery Interfaces in the CED Module User’s Guide. In both study types

initialization is performed by first solving for the distance to the closest wall.

When this physics interface is added, the following physics nodes are also added in the
Model Builder under Turbulent Flow, Low Re k-e— Fluid Properties, Wall and Initial
Values. A Moving Mesh interface with a Rotating Domain node is added automatically in
the Model Builder under the Definitions node. Then, from the Physics toolbar, add other
nodes that implement, for example, boundary conditions and volume forces. You can
also right-click Turbulent Flow, Low Re k-¢ to select physics features from the context
menu. For information about the available physics features, see Domain, Boundary,

Point, and Pair Nodes for the Rotating Machinery Interfaces.

A part for the interface settings defined below, see the advanced settings defined for
The Rotating Machinery, Laminar Flow Interface, and the settings in The Creeping
Flow, Laminar Flow, Turbulent Flow, and Large Eddy Simulation Interfaces in the

CFD Module User’s Guide.

TURBULENCE MODEL PARAMETERS
Turbulence model parameters are optimized to fit as many flow types as possible, but
for some special cases, better performance can be obtained by tuning the model

parameters.

For this physics interface the parameters are C,1, Cpg, Cy, 0, 0, and k.
DEPENDENT VARIABLES

The following dependent variables (fields) are defined for this physics interface:

* Velocity field u and its components
* Pressure p

¢ Turbulent kinetic energy %

CHAPTER 4: ROTATING MACHINERY, FLUID FLOW



¢ Turbulent dissipation rate ep

* Reciprocal wall distance G

The Rotating Machinery, Turbulent Flow, Spalart-Allmaras
Interfoce

The Rotating Machinery, Turbulent Flow, Spalart-Allmaras (spf) interface ( 12 ), found

under the Single-Phase Flow>Rotating Machinery branch (== ) when adding a physics

interface, is used to simulate flow at high Reynolds numbers in geometries with one or
more rotating parts. The physics interface supports incompressible, weakly
compressible and compressible flows at low Mach numbers (typically less than 0.3).

The physics interface is available for 3D and 2D components.

The momentum balance is governed by the Navier-Stokes equations, and the mass
conservation is governed by the continuity equation. Turbulence effects are modeled
using the Spalart-Allmaras one-equation model. The Spalart-Allmaras model is a
so-called low-Reynolds number model, which means that it resolves the flow all the
way down to the wall. The Spalart-Allmaras model depends on the distance to the
closest wall. The physics interface therefore includes a wall distance equation.

There are two study types available for this physics interface. Using the Time Dependent
with Initialization study type, the rotation is achieved through moving mesh
functionality, also known as sliding mesh. Using the Frozen Rotor with Initialization
study type, the rotating parts are kept frozen in position, and the rotation is accounted
for by the inclusion of centrifugal and Coriolis forces. See Theory for the Rotating
Machinery Interfaces in the CFD Module User’s Guide. In both study types

initialization is performed by first solving for the distance to the closest wall.

When this physics interface is added, the following physics nodes are also added in the
Model Builder under Turbulent Flow, Spalart-Allmaras — Fluid Properties, Wall, and Initial
Values. A Moving Mesh interface with a Rotating Domain node is added automatically in
the Model Builder under the Definitions node. Then, from the Physics toolbar, add other
nodes that implement, for example, boundary conditions and volume forces. You can
also right-click Turbulent Flow, Spalart-Allmaras to select physics features from the
context menu. For information about the available physics features, see Domain,
Boundary, Point, and Pair Nodes for the Rotating Machinery Interfaces.

A part for the interface settings defined below, see the advanced settings defined for

The Rotating Machinery, Laminar Flow Interface, and the settings in The Creeping
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Flow, Laminar Flow, Turbulent Flow, and Large Eddy Simulation Interfaces in the
CFD Module User’s Guide.

TURBULENCE MODEL PARAMETERS
Turbulence model parameters are optimized to fit as many flow types as possible, but
for some special cases, better performance can be obtained by tuning the model

parameters.

For this physics interface the parameters are Cy1, Cha, Cy1, Gy, Cwa, Cw3, Ky, and Choy.

ADVANCED SETTINGS

To display this section, click the Show More Options button (“& ) and select Advanced
Physics Options in the Show More Options dialog box. Under the Turbulence variables
scale parameters subsection, the default V¢, is of the same order of magnitude as the

kinematic viscosity of air at room temperature.

DEPENDENT VARIABLES
The following dependent variables (fields) are defined for this physics interface:
¢ Velocity field u and its components

* Pressure p

¢ Reciprocal wall distance G

* Undamped turbulent kinematic viscosity nutilde

The Rotating Machinery, Turbulent Flow, v2-f Interface

The Rotating Machinery, Turbulent Flow, v2-f (spf) interface (= ), found under the

) when add;in'g a physics interface, is

Single-Phase Flow>Rotating Machinery branch (
used to simulate flow at high Reynolds numbers in geometries with one or more
rotating parts. The physics interface supports incompressible, weakly compressible,
weakly compressible and compressible flows at low Mach numbers (typically less than
0.3). The physics interface is available for 3D and 2D components.

The momentum balance is governed by the Navier-Stokes equations, and the mass
conservation is governed by the continuity equation. Turbulence effects are modeled
using the v2-f transport-equation model with realizability constraints. The v2-f model
is a so-called low-Reynolds number model, which means that it can resolve the flow all
the way down to the wall. The physics interface includes a wall distance equation.
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There are two study types available for this physics interface. Using the Time Dependent

with Initialization study type, the rotation is achieved through moving mesh

functionality, also known as sliding mesh. Using the Frozen Rotor with Initialization

study type, the rotating parts are kept frozen in position, and the rotation is accounted

for by the inclusion of centrifugal and Coriolis forces. See Theory for the Rotating
Machinery Interfaces in the CFD Module User’s Guide. In both study types

initialization is performed by first solving for the distance to the closest wall.

When this physics interface is added, the following physics nodes are also added in the

Model Builder under Turbulent Flow, v2-f — Fluid Properties, Wall and Initial Values. A

Moving Mesh interface with a Retating Domain node is added automatically in the Model

Builder under the Definitions node. Then, from the Physics toolbar, add other nodes

that implement, for example, boundary conditions and volume forces. You can also

right-click Turbulent Flow, v2-f to select physics features from the context menu. For

information about the available physics features, see Domain, Boundary, Point, and

Pair Nodes for the Rotating Machinery Interfaces.

A part for the interface settings defined below, see the advanced settings defined for

The Rotating Machinery, Laminar Flow Interface, and the settings in The Creeping

Flow, Laminar Flow, Turbulent Flow, and Large Eddy Simulation Interfaces in the
CFD Module User’s Guide.

TURBULENCE MODEL PARAMETERS

Turbulence model parameters are optimized to fit as many flow types as possible, but

for some special cases, better performance can be obtained by tuning the model

parameters.

For this physics interface the parameters are Cyyor, Cr, Cy, C1, C1, Co, Ceiyap Ceovor
A1, Okyafs Oevass Otvef K> and B.

DEPENDENT VARIABLES

The following dependent variables (fields) are defined for this physics interface:

Velocity field u and its components
Pressure p

Turbulent kinetic energy %
Turbulent dissipation rate ep

Turbulent relative fluctuations zeta
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* Elliptic blending function alpha

¢ Reciprocal wall distance G

Domain, Boundary, Point, and Pair Nodes for the Rotating
Machinery Interfaces

All versions of the Rotating Machinery, Fluid Flow interfaces use the following

domain, boundary, point, and pair physics nodes.

* Contact Angle
* Free Surface
¢ Rotating Shaft

* Stationary Free Surface

The nodes are available under the option Retating Machinery from the Physics ribbon
toolbar (Windows users), Physics context menu (Mac or Linux users), or right-click to

access the context menu (all users).

The following nodes, available in the Fluid Flow interfaces, are described for the
Laminar Flow interface in the CFD Module User’s Guide:

* Boundary Stress ¢ Outlet

 Initial Values e Periodic Flow Condition
* Interior Wall * DPoint Mass Source

* Flow Continuity ¢ Pressure Point Constraint
¢ Fluid Properties e Screen

e Inlet e Symmetry

¢ Line Mass Source ¢ Volume Force

* Open Boundary e Wall

Domain, Boundary, Pair, and Point Nodes for Single-Phase Flow in the
a CFD Module User’s Guide
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Stationary Free Surface

This postprocessing feature is used to estimate the deformation of a free surface from
the pressure distribution on the boundary when using the Frozen Rotor or Frozen Rotor
with Initialization study types. When computing the flow field, a slip condition together
with a constant pressure level pqy; is applied on the boundary. The free surface
deformation 7pg is evaluated from the linearized free surface condition in a separate
study step, Stationary Free Surface, using the pressure from the Frozen Rotor study

step.
P(X0) ~Pege+ M- VP|__ T = -0V (4-1)

ois the surface tension coefficient, X = Xq represents the position of the undisturbed
surface - the feature selection, and n is its unit normal. The correct study sequence
can be triggered by toggling the study window once a selection for the Stationary Free
Surface feature has been made.

The Stationary Free Surface feature is supported by laminar and turbulent flow, and is
applicable for small surface deformations (77pg and its gradient should be small
compared to the dimensions of the computational domain). If the surface deformation
is large, a time-dependent study with a Deforming Domain and a Free Surface feature
should be used instead.

Iterative solvers are necessary to reduce the cost of models with large number of
degrees of freedom. The fluid flow interfaces use a Smoothed aggregation AMG solver
per default. When the Stationary Free Surface feature is active and has a nonempty
selection in a frozen rotor or stationary study step, a Geometric multigrid solver is used

instead to ensure robustness of the model.

The Choice of Solver and Solver Settings in the CFD Module User’s
ﬁ}‘ Guide and Studies and Solvers in the COMSOL Multiphysics Reference
Manual

STATIONARY FREE SURFACE

Enter an External pressure p.; corresponding to the average pressure level on the free
surface.
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SURFACE TENSION
Select the Include surface tension force in momentum equation check box to include the

surface tension force in the momentum equation.

The Surface tension coefficient o (SI unit: N/m) can be specified from predefined
libraries, by selecting Library coefficient, liquid/gas interface (the default) or Library

coefficient, liquid/liquid interface, or be set to User defined.

* For Library coefficient, liquid/gas interface sclect an option from the list — Water/Air
(the default), Acetone/Air, Acetic acid/Air, Ethanol/Air, Ethylene glycol/Ethylene glycol
vapor, Diethyl ether/Air, Glycerol/Air, Heptane/Nitrogen, Mercury/Mercury vapor, or

Toluene/Air.

* For Library coefficient, liquid/liquid interface sclect an option from the list —
Benzene/Water, 20°C, Corn oil/Water, 20°C, Ether/Water, 20°C, Hexane/Water, 20°C,
Mercury/Water, 20°C, or Olive oil/Water, 20°C.

Only one Stationary Free Surface feature can be applied in a Rotating Machinery, Fluid

Flow interface, and it requires the study to be stationary (Frozen Rotor).

Free Surfuce

This feature is used to define the two-phase interface separating the modeled fluid in
a free surface domain from the outer fluid. By applying this boundary condition the
motion of the two-phase interface can be tracked. The free surface follows the fluid
motion in the normal direction. In the tangential direction the free surface motion is
governed by the fluid motion in combination with the surface tension of the fluid-fluid
interface. More information on the Free Surface feature can be found under
Multiphase Flow Interface in the CFD Module User’s Guide.

Contact Angle

This feature specifies the contact angle between the free surface and a solid wall. The
Contact Angle feature is a subfeature to, and added under a Stationary Free Surface or
a Free Surface feature. See the Contact Angle feature under Multiphase Flow Interface
in the CFD Module User’s Guide.

Rotating Shaft

This boundary feature specifies flow conditions on boundaries where the fluid is

subjected to a solid shaft rotation. This feature can be applied to rotating shaft
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boundaries in a free-surface domain modeled by a Deforming Domain that connects to

a rotating shaft in a Rotating Domain.

The flow condition prescribed by the feature corresponds to a rotational velocity
defined from an existing Rotating Domain. In order for the contact line, defined by
intersection of the rotating shaft and the free surface, to be able to move along the
rotating shaft the velocity condition is applied using a Wall boundary condition with
the Navier Slip option for laminar flow. For turbulent flow, wall functions or automatic

wall treatment must be applied.

ROTATING SHAFT

Axis of Rotation

Select the Axis of rotation. If x-axis is selected, this corresponds to a rotational axis
(1, 0, 0) with the origin as the base point. Correspondingly, if y-axis or z-axis is
selected, the rotational axis is defined by a unit vector in the selected direction together
with a base point at the origin. For User defined enter values into these fields: Rotation
axis base point and Rotation axis direction. The z-axis is the default choice and the
default values in the fields for User defined correspond to those for the z-axis.

Angular Velocity
Select the rotating shaft Rotational frequency from the list:

* Select the Revolution per time option to manually define the rotational velocity (SI
unit: rad/s) and select the Rotational direction as Positive angular velocity or Negative
angular velocity. This is the default setting.

* Select the Angular velocity option to manually define the angular velocity (SI unit:
rad/s).
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Rotating Machinery,
Multiphase Flow Interfaces

This chapter describes the rotating machinery physics interfaces found under the
Fluid Flow>Multiphase Flow branch ( ~_ ). In this chapter:

* Modeling Multiphase Flow in Equipment with Rotating Parts

e The Rotating Machinery, Mixture Model Interfaces

* The Rotating Machinery, Phase Transport Mixture Model Interfaces

¢ The Rotating Machinery, Two-Phase Flow, Level Set and Phase Field Interfaces
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Modeling Multiphase Flow in
Equipment with Rotating Parts

Selecting the Right Physics Interface

The Multiphase Flow branch ( = ) has a number of subbranches to describe momentum
transport for multiphase flow in equipment containing one or more rotating parts.
One or more physics interfaces can be added; either singularly or in combination with

other physics interfaces for applications such as mass transfer and energy (heat) transfer.

Different types of flow require different equations to describe them. If you know the
type of flow to model, then select it directly. However, when you are not certain of the
flow type, or when it is difficult to obtain a solution, you can instead start with a
simplified model and add complexity as you build the model. Then you can

successively advance forward, comparing models and results.

The Rotating Machinery, Mixture Model interfaces are appropriate when you want to
simulate a flow with many particles or droplets immersed in a liquid. With these physics
interfaces, you do not track each particle in detail. Instead you solve for the averaged
volume fraction. If you are interested in the exact motion of individual bubbles,

including how the fluid interface deforms due to, for instance, surface tension, use any

of the Rotating Machinery, Two-Phase Flow interfaces.

To model the detailed dynamics of fluid interfaces, either use the level set method or
the phase field method. The Level Set or Phase Field interfaces use an auxiliary
function (the level set and phase field functions, respectively) to track the location of
the interface, which is necessarily diffuse. The Level Set interface does not include
surface tension force per default, and is recommended for use in larger scale problems
with larger velocities, or when the effects of the gradient of the surface tension
coefficient are relevant. The phase field method is physically motivated and is usually
more numerically stable than the level set method. It is can also be extended to more
phases and is compatible with fluid-structure interactions (requires the MEMS Module
or the Structural Mechanics Module). In general, it is not obvious which one of these
to use when the flow is convection dominated. However, when the flow is diffusion
dominated, for example, in the case of phase separation, only phase field should be

used.
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The Rotating Machinery, Mixture

CHAPTER 5:

Model Interfaces

This section describes the physics interfaces found under the Fluid Flow>Multiphase
Flow>Rotating Machinery, Mixture Model branch (:L) In this chapter:
¢ The Rotating Machinery, Mixture Model, Laminar Flow Interface

¢ The Rotating Machinery, Mixture Model, Algebraic yPlus Interface
e The Rotating Machinery, Mixture Model, L-VEL Interface

¢ The Rotating Machinery, Mixture Model, k-€ Interface

* The Rotating Machinery, Mixture Model, Realizable k-€ Interface

e The Rotating Machinery, Mixture Model, k-o Interface

¢ The Rotating Machinery, Mixture Model, SST Interface

¢ The Rotating Machinery, Mixture Model, Low Re k-¢€ Interface

e The Rotating Machinery, Mixture Model, Spalart-Allmaras Interface
¢ The Rotating Machinery, Mixture Model, v2-f Interface

* Domain, Boundary, Pair, and Point Nodes for the Rotating Machinery, Mixture
Model Interfaces

The Rotating Machinery, Mixture Model, Laminar Flow Interface

The Laminar Flow version of the Rotating Machinery, Mixture Model (mm) interface (L)
is used to model low to moderate Reynolds number flow of a multiphase mixture in
equipment containing one or more rotating parts. The mixture consists of a liquid with
dispersed particles, bubbles, liquid droplets, or solid particles, which are assumed to

always travel with terminal velocity.

The interface solves one set of Navier-Stokes equations for the momentum of the
mixture. The pressure distribution is calculated from a mixture-averaged continuity
equation and the velocity of the dispersed phase is described by a slip model. The
dispersed particles are tracked by solving a transport equation for the volume fraction
of the dispersed phase. The physics interface can also model the distribution of the
number density, which in turn can be used to calculate the interfacial area, useful when

simulating chemical reactions in the mixture.

ROTATING MACHINERY, MULTIPHASE FLOW INTERFACES



There are two study types available for this physics interface. For the Time Dependent
study type the rotation is achieved by moving mesh functionality, also known as sliding
mesh. For the Frozen Rotor study type the rotating parts are kept frozen in position,

and the rotation is accounted for by the inclusion of centrifugal and Coriolis forces.

When this physics interface is added, the following default nodes are also added in the
Model Builder under Mixture Model, Laminar Flow — Mixture Properties, Wall, and Initial
Values. A Moving Mesh interface with a Rotating Domain node is added automatically in
the Model Builder under the Definitions node. Then, from the Physics toolbar, add other
nodes that implement, for example, boundary conditions. You can also right-click

Mixture Model, Laminar Flow to select physics features from the context menu.

In previous versions of COMSOL Multiphysics (prior to version 5.5), a
specific physics interface called Rotating Machinery, Mixture Model (rmmf)
was added to the Model Builder. Now, a predefined multiphysics coupling

approach is used, improving the flexibility and design options for your

m

modeling. For specific details, see The Multiphysics Branch and
Multiphysics Modeling Workflow in the COMSOL Multiphysics
Reference Manual.

SETTINGS

The Label is the default physics interface name.

The Name is used primarily as a scope prefix for variables defined by the physics
interface. Refer to such physics interface variables in expressions using the pattern
<name>.<variable_name>. In order to distinguish between variables belonging to
different physics interfaces, the name string must be unique. Only letters, numbers, and

underscores (_) are permitted in the Name field. The first character must be a letter.
The default Name (for the first physics interface in the model) is mm.

Most of the physics interface settings are the same as described for The Mixture Model,
Laminar Flow Interface in the CFD Module User’s Guide, and for Moving Mesh.
Only unique settings are discussed below.

ADVANCED SETTINGS

To display this section, click the Show More Options button ("= ) and select Advanced
Physics Options in the Show More Options dialog box. Normally these settings do not
need to be changed.
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Pseudo Time Stepping

Select the Use pseudo time stepping for stationary equation form check box to add
pseudo time derivatives to the equation when the Frozen Rotor equation form is used.
(Frozen rotor is a pseudo stationary formulation.) When selected, also choose a CFL
number expression — Automatic (the default) or Manual. Automatic sets the local CFL
number (from the Courant-Friedrichs—Lewy condition) to the built-in variable
CFLCMP which in turn triggers a PID regulator for the CFL number. For Manual enter
a Local CFL number CFL, . (dimensionless).

Pseudo Time Stepping for Laminar Flow Models in the CED Module
lﬂ User’s Guide

DEPENDENT VARIABLES

Enter values for the dependent variables (field variables):
* Velocity field, mixture u (SI unit: m/s)

* Pressure p (SI unit: Pa)

¢ Volume fraction, dispersed phase phid (dimensionless)
¢ Squared slip velocity slipvel

¢ Number density, dispersed phase nd (SI unit: l/ms)

The names can be changed, but the names of fields and dependent variables must be

unique within a component.

The Rotating Machinery, Mixture Model, Algebraic yPlus Interface

The Rotating Machinery, Mixture Model, Algebraic yPlus (mm) interface (717) is used to
model high Reynolds number flow of a multiphase mixture in equipment containing
one or more rotating parts. The mixture consists of a liquid with dispersed particles,
bubbles, liquid droplets, or solid particles, which are assumed to always travel with

terminal velocity.

The interface solves one set of Navier-Stokes equations for the momentum of the
mixture. The pressure distribution is calculated from a mixture-averaged continuity
equation and the velocity of the dispersed phase is described by a slip model. The
dispersed particles are tracked by solving a transport equation for the volume fraction

of the dispersed phase. Turbulence effects are included using and enhanced viscosity
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model based on the scaled wall distance, and the physics interface therefore includes a

wall distance equation.

The physics interface can also model the distribution of the number density, which in
turn can be used to calculate the interfacial area, useful when simulating chemical

reactions in the mixture.

There are two study types available for this physics interface. Using the Time Dependent
with Initialization study type, the rotation is achieved through moving mesh
functionality, also known as sliding mesh. Using the Frozen Rotor with Initialization
study type, the rotating parts are kept frozen in position, and the rotation is accounted
for by the inclusion of centrifugal and Coriolis forces. All study types include an initial
Wall Distance Initialization step in order to compute the wall distance. See Theory for
the Rotating Machinery Interfaces in the CFD Module User’s Guide.

When this physics interface is added, the following default nodes are also added in the
Model Builder, under Mixture Model, Algebraic yPlus — Mixture Properties, Wall, and
Initial Values. A Moving Mesh interface with a Rotating Domain node is added
automatically in the Model Builder under the Definitions node. Then, from the Physics
toolbar, add other nodes that implement, for example, boundary conditions. You can
also right-click Mixture Model, Algebraic yPlus to select physics features from the context

menu.

The physics interface settings are the same as described for The Rotating Machinery,
Mixture Model, Laminar Flow Interface, for Moving Mesh, and for The Mixture
Model, Algebraic yPlus Interface in the CFD Module User’s Guide.

The Rotating Machinery, Mixture Model, L-VEL Interface

The Rotating Machinery, Mixture Model, L-VEL (mm) interface (_J_) is used to model
high Reynolds number flow of a multiphase mixture in equipment containing one or
more rotating parts. The mixture consists of a liquid with dispersed particles, bubbles,
liquid droplets, or solid particles, which are assumed to always travel with terminal

velocity.

The interface solves one set of Navier-Stokes equations for the momentum of the
mixture. The pressure distribution is calculated from a mixture-averaged continuity
equation and the velocity of the dispersed phase is described by a slip model. The
dispersed particles are tracked by solving a transport equation for the volume fraction

of the dispersed phase. Turbulence effects are included using and enhanced viscosity
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model based on the local wall distance, and the physics interface therefore includes a

wall distance equation.

The physics interface can also model the distribution of the number density, which in
turn can be used to calculate the interfacial area, useful when simulating chemical

reactions in the mixture.

There are two study types available for this physics interface. Using the Time Dependent
with Initialization study type, the rotation is achieved through moving mesh
functionality, also known as sliding mesh. Using the Frozen Rotor with Initialization
study type, the rotating parts are kept frozen in position, and the rotation is accounted
for by the inclusion of centrifugal and Coriolis forces. All study types include an initial
Wall Distance Initialization step in order to compute the wall distance. See Theory for
the Rotating Machinery Interfaces in the CFD Module User’s Guide.

When this physics interface is added, the following default nodes are also added in the
Model Builder, under Mixture Model, L-VEL — Mixture Properties, Wall, and Initial Values.
A Moving Mesh interface with a Rotating Domain node is added automatically in the
Model Builder under the Definitions node. Then, from the Physics toolbar, add other
nodes that implement, for example, boundary conditions. You can also right-click

Mixture Model, L-VEL to sclect physics features from the context menu.

The physics interface settings are the same as described for The Rotating Machinery,
Mixture Model, Laminar Flow Interface, for Moving Mesh, and for The Mixture
Model, L-VEL Interface in the CED Module User’s Guide.

The Rotating Machinery, Mixture Model, k-€ Interface

The Rotating Machinery, Mixture Model, k-€ (mm) interface (J‘f) is used to model high
Reynolds number flow of a multiphase mixture in equipment containing one or more
rotating parts. The mixture consists of a liquid with dispersed particles, bubbles, liquid

droplets, or solid particles, which are assumed to always travel with terminal velocity.

The interface solves one set of Navier-Stokes equations for the momentum of the
mixture. The pressure distribution is calculated from a mixture-averaged continuity
equation and the velocity of the dispersed phase is described by a slip model. The
dispersed particles are tracked by solving a transport equation for the volume fraction
of the dispersed phase. Turbulence effects are modeled using the standard
two-equation k-& model with realizability constraints. Flow close to walls is modeled

using wall functions.
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The physics interface can also model the distribution of the number density, which in
turn can be used to calculate the interfacial area, useful when simulating chemical

reactions in the mixture.

There are two study types available for this physics interface. For the Time Dependent
study type the rotation is achieved by moving mesh functionality, also known as sliding
mesh. For the Frozen Rotor study type the rotating parts are kept frozen in position,

and the rotation is accounted for by the inclusion of centrifugal and Coriolis forces.

When this physics interface is added, the following default nodes are also added in the
Model Builder, under Mixture Model, k- — Mixture Properties, Wall, and Initial Values.
A Moving Mesh interface with a Rotating Domain node is added automatically in the
Model Builder under the Definitions node. Then, from the Physics toolbar, add other
nodes that implement, for example, boundary conditions. You can also right-click

Mixture Model, k-€ to select physics features from the context menu.

The physics interface settings are the same as described for The Rotating Machinery,
Mixture Model, Laminar Flow Interface, for Moving Mesh, and for The Mixture
Model, k- £ Interface in the CFD Module User’s Guide.

In previous versions of COMSOL Multiphysics (prior to version 5.4), a
specific physics interface called Rotating Machinery, Mixture Model (rmmf)
was added to the Model Builder. Now, a predefined multiphysics coupling

approach is used, improving the flexibility and design options for your

m

modeling. For specific details, see The Multiphysics Branch and
Multiphysics Modeling Workflow in the COMSOL Multiphysics
Reference Manual.

The Rotating Machinery, Mixture Model, Realizable k-¢ Interface

The Rotating Machinery, Mixture Model, Realizable k- (mm) interface (:(j:_‘?)) is used to
model high Reynolds number flow of a multiphase mixture in equipment containing
one or more rotating parts. The mixture consists of a liquid with dispersed particles,
bubbles, liquid droplets, or solid particles, which are assumed to always travel with

terminal velocity.

The interface solves one set of Navier-Stokes equations for the momentum of the
mixture. The pressure distribution is calculated from a mixture-averaged continuity
equation and the velocity of the dispersed phase is described by a slip model. The

dispersed particles are tracked by solving a transport equation for the volume fraction
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of the dispersed phase. Turbulence effects are modeled using the realizable

two-equation k-€ model. Flow close to walls is modeled using wall functions.

The physics interface can also model the distribution of the number density, which in
turn can be used to calculate the interfacial area, useful when simulating chemical

reactions in the mixture.

There are two study types available for this physics interface. For the Time Dependent
study type the rotation is achieved by moving mesh functionality, also known as sliding
mesh. For the Frozen Rotor study type the rotating parts are kept frozen in position,

and the rotation is accounted for by the inclusion of centrifugal and Coriolis forces.

When this physics interface is added, the following default nodes are also added in the
Model Builder, under Mixture Model, Realizable k- — Mixture Properties, Wall, and Initial
Values. A Moving Mesh interface with a Rotating Domain node is added automatically in
the Model Builder under the Definitions node. Then, from the Physics toolbar, add other
nodes that implement, for example, boundary conditions. You can also right-click

Mixture Model, Realizable k-¢ to select physics features from the context menu.

The physics interface settings are the same as described for The Rotating Machinery,
Mixture Model, Laminar Flow Interface, for Moving Mesh, and for The Mixture
Model, Realizable k-£ Interface in the CED Module User’s Guide.

The Rotating Machinery, Mixture Model, k- Interface

The Rotating Machinery, Mixture Model, k- (mm) interface ( J:fi ) is used to model high
Reynolds number flow of a multiphase mixture in equipment containing one or more
rotating parts. The mixture consists of a liquid with dispersed particles, bubbles, liquid

droplets, or solid particles, which are assumed to always travel with terminal velocity.

The interface solves one set of Navier-Stokes equations for the momentum of the
mixture. The pressure distribution is calculated from a mixture-averaged continuity
equation and the velocity of the dispersed phase is described by a slip model. The
dispersed particles are tracked by solving a transport equation for the volume fraction
of the dispersed phase. Turbulence effects are modeled using the Wilcox revised
two-equation k-® model with realizability constraints. The - model is a so-called
low-Reynolds-number model, which means that it can resolve the flow all the way

down to the wall.

The physics interface can also model the distribution of the number density, which in
turn can be used to calculate the interfacial area, useful when simulating chemical

reactions in the mixture.
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There are two study types available for this physics interface. For the Time Dependent
study type the rotation is achieved by moving mesh functionality, also known as sliding
mesh. For the Frozen Rotor study type the rotating parts are kept frozen in position,

and the rotation is accounted for by the inclusion of centrifugal and Coriolis forces.

When this physics interface is added, the following default nodes are also added in the
Model Builder, under Mixture Model, k-0 — Mixture Properties, Wall, and Initial Values.
A Moving Mesh interface with a Rotating Domain node is added automatically in the
Model Builder under the Definitions node. Then, from the Physics toolbar, add other
nodes that implement, for example, boundary conditions. You can also right-click

Mixture Model, k- to select physics features from the context menu.

The physics interface settings are the same as described for The Rotating Machinery,
Mixture Model, Laminar Flow Interface, for Moving Mesh, and for The Mixture
Model, k- @ Interface in the CFD Module User’s Guide.

The Rotating Machinery, Mixture Model, SST Interface

The Rotating Machinery, Mixture Model, SST (mm) interface (Zj:fi ) is used to model high

Reynolds number flow of a multiphase mixture in equipment containing one or more
rotating parts. The mixture consists of a liquid with dispersed particles, bubbles, liquid

droplets, or solid particles, which are assumed to always travel with terminal velocity.

The interface solves one set of Navier-Stokes equations for the momentum of the
mixture. The pressure distribution is calculated from a mixture-averaged continuity
equation and the velocity of the dispersed phase is described by a slip model. The
dispersed particles are tracked by solving a transport equation for the volume fraction
of the dispersed phase. Turbulence effects are modeled using the Menter shear-stress
transport (SST) two-equation model from 2003 with realizability constraints. The SST
model is a so-called low-Reynolds-number model, which means that it can resolve the
flow all the way down to the wall. The SST model depends on the distance to the

closest wall. The physics interface therefore includes a wall distance equation.

The physics interface can also model the distribution of the number density, which in
turn can be used to calculate the interfacial area, useful when simulating chemical

reactions in the mixture.

There are two study types available for this physics interface. Using the Time Dependent
with Initialization study type, the rotation is achieved through moving mesh
functionality, also known as sliding mesh. Using the Frozen Rotor with Initialization

study type, the rotating parts are kept frozen in position, and the rotation is accounted
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for by the inclusion of centrifugal and Coriolis forces. All study types include an initial
Wall Distance Initialization step in order to compute the wall distance. See Theory for
the Rotating Machinery Interfaces in the CED Module User’s Guide.

When this physics interface is added, the following default nodes are also added in the
Model Builder, under Mixture Model, SST — Mixture Properties, Wall, and Initial Values.
A Moving Mesh interface with a Rotating Domain node is added automatically in the
Model Builder under the Definitions node. Then, from the Physics toolbar, add other
nodes that implement, for example, boundary conditions. You can also right-click

Mixture Model, SST to sclect physics features from the context menu.

The physics interface settings are the same as described for The Rotating Machinery,
Mixture Model, Laminar Flow Interface, for Moving Mesh, and for The Mixture
Model, SST Interface in the CFD Module User’s Guide.

The Rotating Machinery, Mixture Model, Low Re k-¢ Interface

The Rotating Machinery, Mixture Model, Low Re k- (mm) interface (717) is used to
model high Reynolds number flow of a multiphase mixture in equipment containing
one or more rotating parts. The mixture consists of a liquid with dispersed particles,
bubbles, liquid droplets, or solid particles, which are assumed to always travel with

terminal velocity.

The interface solves one set of Navier-Stokes equations for the momentum of the
mixture. The pressure distribution is calculated from a mixture-averaged continuity
equation and the velocity of the dispersed phase is described by a slip model. The
dispersed particles are tracked by solving a transport equation for the volume fraction
of the dispersed phase. Turbulence effects are modeled using the AKN two-equation
k-& model with realizability constraints. The AKN model is a so-called
low-Reynolds-number model, which means that it can resolve the flow all the way
down to the wall. The AKN model depends on the distance to the closest wall. The
physics interface therefore includes a wall distance equation.

The physics interface can also model the distribution of the number density, which in
turn can be used to calculate the interfacial area, useful when simulating chemical

reactions in the mixture.

There are two study types available for this physics interface. Using the Time Dependent
with Initialization study type, the rotation is achieved through moving mesh
functionality, also known as sliding mesh. Using the Frozen Rotor with Initialization

study type, the rotating parts are kept frozen in position, and the rotation is accounted
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for by the inclusion of centrifugal and Coriolis forces. All study types include an initial
Wall Distance Initialization step in order to compute the wall distance. See Theory for
the Rotating Machinery Interfaces in the CFD Module User’s Guide.

When this physics interface is added, the following default nodes are also added in the
Model Builder, under Mixture Model, Low Re k-¢ — Mixture Properties, Wall, and Initial
Values. A Moving Mesh interface with a Rotating Domain node is added automatically in
the Model Builder under the Definitions node. Then, from the Physics toolbar, add other
nodes that implement, for example, boundary conditions. You can also right-click

Mixture Model, Low Re k-€ to select physics features from the context menu.

The physics interface settings are the same as described for The Rotating Machinery,
Mixture Model, Laminar Flow Interface, for Moving Mesh, and for The Mixture
Model, Low Re k-& Interface in the CFD Module User’s Guide.

The Rotating Machinery, Mixture Model, Spalart-Allmaras
Interface

The Rotating Machinery, Mixture Model, Spalart-Allmaras (mm) interface (;l:f) is used to
model high Reynolds number flow of a multiphase mixture in equipment containing
one or more rotating parts. The mixture consists of a liquid with dispersed particles,
bubbles, liquid droplets, or solid particles, which are assumed to always travel with

terminal velocity.

The interface solves one set of Navier-Stokes equations for the momentum of the
mixture. The pressure distribution is calculated from a mixture-averaged continuity
equation and the velocity of the dispersed phase is described by a slip model. The
dispersed particles are tracked by solving a transport equation for the volume fraction
of the dispersed phase. Turbulence effects are modeled using the Spalart-Allmaras
one-equation model. The Spalart-Allmaras model is a so-called low-Reynolds-number
model, which means that it can resolve the flow all the way down to the wall. The
Spalart-Allmaras model depends on the distance to the closest wall. The physics

interface therefore includes a wall distance equation.

The physics interface can also model the distribution of the number density, which in
turn can be used to calculate the interfacial area, useful when simulating chemical

reactions in the mixture.

There are two study types available for this physics interface. Using the Time Dependent
with Initialization study type, the rotation is achieved through moving mesh

functionality, also known as sliding mesh. Using the Frozen Rotor with Initialization
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study type, the rotating parts are kept frozen in position, and the rotation is accounted
for by the inclusion of centrifugal and Coriolis forces. All study types include an initial
Wall Distance Initialization step in order to compute the wall distance. See Theory for
the Rotating Machinery Interfaces in the CFD Module User’s Guide.

When this physics interface is added, the following default nodes are also added in the
Model Builder, under Mixture Model, Spalart-Allmaras — Mixture Properties, Wall, and
Initial Values. A Moving Mesh interface with a Rotating Domain node is added
automatically in the Model Builder under the Definitions node. Then, from the Physics
toolbar, add other nodes that implement, for example, boundary conditions. You can
also right-click Mixture Model, Spalart-Allmaras to select physics features from the

context menu.

The physics interface settings are the same as described for The Rotating Machinery,
Mixture Model, Laminar Flow Interface, for Moving Mesh, and for The Mixture
Model, Spalart-Allmaras Interface in the CED Module User’s Guide.

The Rotating Machinery, Mixture Model, v2-f Interface

The Rotating Machinery, Mixture Model, v2-f (mm) interface (tl’fé ) is used to model high
Reynolds number flow of a multiphase mixture in equipment containing one or more
rotating parts. The mixture consists of a liquid with dispersed particles, bubbles, liquid

droplets, or solid particles, which are assumed to always travel with terminal velocity.

The interface solves one set of Navier-Stokes equations for the momentum of the
mixture. The pressure distribution is calculated from a mixture-averaged continuity
equation and the velocity of the dispersed phase is described by a slip model. The
dispersed particles are tracked by solving a transport equation for the volume fraction
of the dispersed phase. Turbulence effects are modeled using the v2-f
transport-equation model with realizability constraints. The v2-f model is a so-called
low-Reynolds-number model, which means that it can resolve the flow all the way
down to the wall. The v2-f model depends on the distance to the closest wall. The

physics interface therefore includes a wall distance equation.

The physics interface can also model the distribution of the number density, which in
turn can be used to calculate the interfacial area, useful when simulating chemical

reactions in the mixture.

There are two study types available for this physics interface. Using the Time Dependent
with Initialization study type, the rotation is achieved through moving mesh

functionality, also known as sliding mesh. Using the Frozen Rotor with Initialization
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study type, the rotating parts are kept frozen in position, and the rotation is accounted
for by the inclusion of centrifugal and Coriolis forces. All study types include an initial
Wall Distance Initialization step in order to compute the wall distance. See Theory for
the Rotating Machinery Interfaces in the CED Module User’s Guide.

When this physics interface is added, the following default nodes are also added in the
Model Builder, under Mixture Model, v2-f — Mixture Properties, Wall, and Initial Values.
A Moving Mesh interface with a Rotating Domain node is added automatically in the
Model Builder under the Definitions node. Then, from the Physics toolbar, add other
nodes that implement, for example, boundary conditions. You can also right-click

Mixture Model, v2-f to select physics features from the context menu.

The physics interface settings are the same as described for The Rotating Machinery,
Mixture Model, Laminar Flow Interface, for Moving Mesh, and for The Mixture
Model, v2-f Interface in the CFD Module User’s Guide.

Domain, Boundary, Pair, and Point Nodes for the Rotating
Machinery, Mixture Model Interfaces

All versions of the Rotating Machinery, Mixture Model interfaces include the

following domain, boundary, pair, and point nodes:

* Contact Angle
¢ Free Surface

* Rotating Shaft

The nodes are available from the Physics ribbon toolbar (Windows users), Physics
context menu (Mac or Linux users), or right-click to access the context menu (all

users).
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The following nodes (listed in alphabetical order) are described for the Mixture Model
interface in the CFED Module User’s Guide:

* Gravity * Outlet

¢ Initial Values ¢ Periodic Flow Condition

e Inlet o Pressure Point Constraint!
* Interior Wall * Symmetry

¢ Mass Transfer + Volume Forcel

e Mixture Properties e Wall

* Mixture Continuity

1 Described for the Laminar Flow interface in the CFD Module User’s Guide.

Free Surface

The Free Surface node is used to define the free surface separating an interior modeled
fluid from the outer fluid. The free surface follows the fluid motion, in the normal
direction, and is governed by the fluid motion in the free surface domain and the
surface tension of the fluid-fluid interface. The Free Surface node can only be applied
to outer boundaries of a Deforming Domain that do not have any boundary condition

assigned under Moving Mesh.

To control the attachment angle between the free surface and adjacent walls, a Contact

Angle node is by default added under the Free Surface node.

The Free Surface feature is supported by laminar flow and by turbulence models using
wall functions or automatic wall treatment, but not low-Reynolds number wall
treatment. It also requires the study to be time dependent. The node is inactive for

Frozen Rotor studies.

FREE SURFACE
Enter an External pressure pgy (SI unit: Pa) corresponding to the pressure level in the

external fluid phase.
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SURFACE TENSION
The Surface tension coefficient o (SI unit: N/m) can be specified from predefined
libraries, by selecting Library coefficient, liquid/gas interface (the default) or Library

coefficient, liquid/liquid interface, or sect to User defined.

¢ For Library coefficient, liquid/gas interface sclect an option from the list — Water/Air
(the default), Acetone/Air, Acetic acid/Air, Ethanol/Air, Ethylene glycol/Ethylene glycol
vapor, Diethyl ether/Air, Glycerol/Air, Heptane/Nitrogen, Mercury/Mercury vapor, or
Toluene/Air.

* For Library coefficient, liquid/liquid interface sclect an option from the list —
Benzene/Water, 20°C, Corn oil/Water, 20°C, Ether/Water, 20°C, Hexane/Water, 20°C,
Mercury/Water, 20°C, or Olive oil/Water, 20°C.

DISPERSED PHASE BOUNDARY CONDITION
Select an option from the Dispersed phase boundary condition list — No dispersed phase
flux (the default), Dispersed phase concentration, Dispersed phase outlet, Dispersed phase

flux, or Symmetry.

* For Dispersed phase concentration cnter a Dispersed phase volume fraction ¢,
(dimensionless). The default is 0. When Solve for interfacial area is selected under
the Physical Model section, select either the Dispersed phase number density 72
(ST unit: 1/m3) or Diameter of particles/droplets dj (SI unit: m) button and enter a
value or expression for ng (the default is 51001 / m3) or dq (the default is 1 mm).

* For Dispersed phase flux enter values or expression for the Dispersed phase flux N, od
(ST unit: m/s) and, if Solve for interfacial area is sclected under the Physical Model
section, the Number density flux N, (SI unit: 1/(m2~s)). The defaults are 0 m/s and
0 l/(m2~s), respectively.

Dispersed Phase Boundary Condition Equations in the CFD Module
@ User’s Guide
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The Free Surface feature imposes a mesh deformation in the normal
direction. On adjacent boundaries, the mesh displacement parallel to
those boundaries cannot be fixed if the contact point is moving. In this
case a Mesh Slip, Symmetry/Roller, Prescribed Normal Mesh
Displacement, or Prescribed Normal Mesh Velocity boundary condition
under Moving Mesh should be selected. A Mesh Slip condition is
automatically used on the boundaries that are adjacent to the Free Surface

and dot not have a prescribed Moving Mesh boundary condition.

[

If a Free Surface feature is in contact with a solid boundary, the movement
of the contact point is not compatible with the no slip condition. For
laminar flow the Wall feature with the Navier Slip option should be
selected. For turbulence models with wall functions or automatic wall

treatment the Wall feature with the No Slip option can be selected.

CHAPTER 5:

Contact Angle

This feature specifies the contact angle between the free surface and a solid wall. The

Contact Angle feature is a subfeature to, and added under a Free Surface feature.

CONTACT ANGLE

Select an option from the Specify contact angle list — Directly (the default) or Through

Young’s equation.

For Directly enter a Contact angle 6, (SI unit: rad). The default is ©/2.

For Through Young’s equation enter values or expressions for Phase 1-Solid surface

energy density %; (SI unit: ]/mz) and Phase 2-Solid surface energy density jo (SI
unit: J/ m?> ).

This condition applies forces on the wall that balance the surface tension for the

prescribed contact angle.

For laminar flow, the Contact Angle node should be used on edges or points where a

Navier Slip wall boundary condition is applied adjacent to the free surface. In this case,

the Navier Slip condition is required for the contact line to move along the wall.
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The representation of the contact angle is dependent on the mesh resolution in the
region where the fluid-fluid interface attaches to the wall. If, during the simulation, the
contact angle is found to fluctuate around a given value, this indicates that the
resolution needs to be improved. This can for example be achieved by adding more

mesh boundary layers on the wall.

The moving mesh boundary condition must be compatible with the

n motion of the wall for the problem to have a valid solution.

Rotating Shaft

Use the Rotating Shaft node to define boundaries where the fluid is subjected to a solid
shaft rotation. This feature should be applied to boundaries outside of, but connecting
to, a Rotating Domain. This feature can be applied to rotating shaft boundaries in a

free-surface domain modeled by a Deforming Domain.

ROTATING SHAFT

Axis of Rotation

Select the Axis of rotation. If x-axis is selected, this corresponds to a rotational axis
(1, 0, 0) with the origin as the base point. Correspondingly, if y-axis or z-axis is
selected, the rotational axis is defined by a unit vector in the selected direction together
with a base point at the origin. For User defined enter values into these fields: Rotation
axis base point and Rotation axis direction. The z-axis is the default choice and the

default values in the fields for User defined correspond to those for the z-axis.

Angular Velocity
Select the rotating shaft Rotational frequency from the list:

* Seclect the Revolution per time option to manually define the rotational velocity (SI
unit: rad/s) and select the Rotational direction as Positive angular velocity or Negative

angular velocity. This is the default setting.

* Select the Angular velocity option to manually define the angular velocity (SI unit:
rad/s).
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DISPERSED PHASE BOUNDARY CONDITION
Select an option from the Dispersed phase boundary condition list — No dispersed phase
flux (the default), Dispersed phase concentration, Dispersed phase outlet, Dispersed phase

flux, or Symmetry.

* For Dispersed phase concentration enter a Dispersed phase volume fraction 04,
(dimensionless). The default is 0. When Solve for interfacial area is selected under
the Physical Model section, select either the Dispersed phase number density n
(ST unit: l/ms) or Diameter of particles/droplets d 4 (SI unit: m) button and enter a

value or expression for ng (the default is 5.108 l/ms) or dq (the default is 1 mm).

* For Dispersed phase flux enter values or expression for the Dispersed phase flux N¢d
(SI unit: m/’s) and, if Solve for interfacial area is sclected under the Physical Model
section, the Number density flux N, (SI unit: 1/(m2~s)). The defaults are 0 m/s and
0 1/(m2-s), respectively.

Dispersed Phase Boundary Condition Equations in the CFD Module
@ User’s Guide
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The Rotating Machinery, Phase
Transport Mixture Model Interfaces

This section includes the following topics:

* The Rotating Machinery, Phase Transport Mixture Model Laminar Flow Interface

* The Rotating Machinery, Phase Transport Mixture Model Turbulent Flow

Interfaces

¢ Domain, Boundary, Edge, Point, and Pair Nodes for the Rotating Machinery, Phase

Transport Mixture Model Interfaces

The Rotating Machinery, Phase Transport Mixture Model Laminar
Flow Interface

The Rotating Machinery, Phase Transport Mixture Model Laminar Flow multiphysics
interface ( 717) found under the Multiphase Flow>Rotating Machinery, Phase Transport
Mixture Model branch (L ), is a multiphysics interface designed to simulate the
coupling between phasc_t}ansport and fluid flow in equipment containing one or more
rotating parts. The flow is assumed to be laminar, that is, to be of low to moderate

Reynolds number.

This physics interface combines the capabilities of the Rotating Machinery, Laminar

Flow interface and the Phase Transport interface. It is available in 2D and 3D.

When adding the Rotating Machinery, Phase Transport Mixture Model Laminar Flow
multiphysics interface, a Laminar Flow and a Phase Transport interface are added to the
Model Builder. A Moving Mesh interface with a Rotating Domain node is added
automatically in the Model Builder under the Definitions node. In addition, a
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multiphysics coupling feature, Mixture Model, is added automatically under the
Multiphysics node..

* Domain, Boundary, Edge, Point, and Pair Nodes for the Rotating

Machinery, Phase Transport Mixture Model Interfaces

* Moving Mesh

In the CFD Module User’s Guide:

@,

* The Phase Transport Mixture Model Interfaces
* Theory for the Phase Transport Mixture Model Interfaces
* Theory for the Single-Phase Flow Interfaces

e Theory for the Phase Transport Interfaces

The Rotating Machinery, Phase Transport Mixture Model Turbulent
Flow Interfaces

The Rotating Machinery, Phase Transport Mixture Model Turbulent Flow multiphysics
interfaces (_J_) found under the Multiphase Flow>Rotating Machinery, Phase Transport
Mixture Model>Turbulent Flow branch (_L ), are multiphysics interfaces designed to
simulate the coupling between phase tra_n_sport and fluid flow in equipment containing
one or more rotating parts. The flow is assumed to be turbulent, that is, to be of high

Reynolds number.

When adding a Rotating Machinery, Phase Transport Mixture Model Turbulent Flow
multiphysics interface, a Turbulent Flow interface and a Phase Transport interface are
added in the Model Builder. A Moving Mesh interface with a Rotating Domain node is
added automatically in the Model Builder under the Definitions node. In addition, a
multiphysics coupling feature, Mixture Model, is automatically added under the
Multiphysics node.

¢ The Turbulent Flow, Algebraic yPlus interface (:L) combines a Phase Transport
interface with a Turbulent Flow, Algebraic yPlus interface and a Rotating Domain.

¢ The Turbulent Flow, L-VEL interface (L ) combines a Phase Transport interface with

a Turbulent Flow, L-VEL interface and a Rotating Domain.

) combines a Phase Transport interface with a

Rotating Domain.

¢ The Turbulent Flow, k-¢ interface (

Turbulent Flow, k-€ interface and:a
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¢ The Turbulent Flow, Realizable k-¢ interface (l) combines a Phase Transport

interface with a Turbulent Flow, Realizable k-€ interface and a Rotating Domain.

¢ The Turbulent Flow, k-0 interface

a Turbulent Flow, k- interface and a Rotating Domain.

e The Turbulent Flow, SST interface (_L ) combines a Phase Transport interface with

a Turbulent Flow, SST interface and a Rotating Domain.

* The Turbulent Flow, Low Re k-¢ interface (*

with a Turbulent Flow, Low Re k-¢ interface and a Rotating Domain.

e The Turbulent Flow, Spalart-Allmaras interface (

~

combines a Phase Transport

interface with a Turbulent Flow, Spalart-Allmaras interface and a Rotating Domain.

* The Turbulent Flow, v2-f interface (=

a Turbulent Flow, v2-f interface and a Rotating Domain.

INTERFACE PROPERTIES

Turbulence Model

By default the Turbulence model type in the settings of the Turbulent Flow interface is

set to RANS. A different turbulence model can be selected under Turbulence model.

combines a Phase Transport interface with

/) combines a Phase Transport interface

’) combines a Phase Transport interface with

In the CFD Module User’s Guide:

* Theory for the Phase Transport Mixture Model Interfaces

@,

e Theory for the Single-Phase Flow Interfaces

e Theory for the Phase Transport Interfaces

Domain, Boundary, Edge, Point, and Pair Nodes for the Rotating
Muachinery, Phase Transport Mixture Model Interfaces

Physics nodes are available from the Physics ribbon toolbar (Windows users), Physics
context menu (Mac or Linux users), or right-click to access the context menu (all

users).

In general, to add a node, go to the Physics toolbar, no matter what
g operating system you are using.
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PHASE TRANSPORT
The available physics features for The Phase Transport Interfaces are listed in the
section Domain, Boundary, Edge, and Point Nodes for the Phase Transport and Phase

Transport in Porous Media Interfaces.

LAMINAR FLOW

The available physics features for The Rotating Machinery, Laminar Flow Interface are
listed in the section Domain, Boundary, Point, and Pair Nodes for the Rotating
Machinery Interfaces.

TURBULENT FLOW, ALGEBRAIC YPLUS

The available physics features for The Rotating Machinery, Turbulent Flow, Algebraic
yPlus Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for
the Rotating Machinery Interfaces.

TURBULENT FLOW, L-VEL
The available physics features for The Rotating Machinery, Turbulent Flow, L-VEL
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the

Rotating Machinery Interfaces.

TURBULENT FLOW, k-t
The available physics features for The Rotating Machinery, Turbulent Flow, k-€
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the

Rotating Machinery Interfaces.

TURBULENT FLOW, REALIZABLE k-¢
The available physics features for The Rotating Machinery, Turbulent Flow, Realizable
k-g Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the

Rotating Machinery Interfaces.

TURBULENT FLOW, k-0
The available physics features for The Rotating Machinery, Turbulent Flow, k-m
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the

Rotating Machinery Interfaces.

TURBULENT FLOW, SST

The available physics features for The Rotating Machinery, Turbulent Flow, SST
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the
Rotating Machinery Interfaces.
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TURBULENT FLOW, LOW RE k-¢
The available physics features for The Rotating Machinery, Turbulent Flow, Low Re
k-g Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the

Rotating Machinery Interfaces.

TURBULENT FLOW, SPALART-ALLMARAS

The available physics features for The Rotating Machinery, Turbulent Flow,
Spalart-Allmaras Interface are listed in the section Domain, Boundary, Point, and Pair
Nodes for the Rotating Machinery Interfaces.

TURBULENT FLOW, V2-F

The available physics features for The Rotating Machinery, Turbulent Flow, v2-f
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the
Rotating Machinery Interfaces.

THE PHASE TRANSPORT MIXTURE MODEL MULTIPHYSICS COUPLING
The Rotating Machinery, Phase Transport Mixture Model Laminar Flow Interface and
The Rotating Machinery, Phase Transport Mixture Model Turbulent Flow Interfaces

contain a multiphysics coupling feature, Mixture Model, which is added automatically.

THE ROTATING MACHINERY, PHASE TRANSPORT MIXTURE MODEL INTERFACES |

117



The Rotating Machinery, Two-Phase
Flow, Level Set and Phase Field
Interfaces

This section includes the following topics:

* The Rotating Machinery, Laminar Two-Phase Flow, Level Set Interface

¢ The Rotating Machinery, Turbulent Two-Phase Flow, Level Set Interfaces

¢ The Rotating Machinery, Laminar Two-Phase Flow, Phase Field Interface

¢ The Rotating Machinery, Turbulent Two-Phase Flow, Phase Field Interfaces

* Domain, Boundary, Edge, Point, and Pair Nodes for the Rotating Machinery,

Two-Phase Flow Interfaces

@ Mathematics, Moving Interface Branch in the CED Module User’s Guide

The Rotating Machinery, Laminar Two-Phase Flow, Level Set
Interfoce

The Rotating Machinery, Laminar Flow, Level Set multiphysics interface (jl,) found
under the Multiphase Flow>Rotating Machinery, Two-Phase Flow, Level Set branch (Il) ),
is a multiphysics interface designed to track the interface between two immiscible fluids
in equipment containing one or more rotating parts. The flow is assumed to be

laminar, that is, to be of low to moderate Reynolds number.

This physics interface combines the capabilities of the Rotating Machinery, Laminar
Flow interface and the Level Set interface. It is available in 2D and 3D.

When adding the Rotating Machinery, Laminar Two-Phase Flow, Level Set multiphysics
interface, a Laminar Flow and a Level Set interface are added to the Model Builder. A
Moving Mesh interface with a Retating Domain node is added automatically in the Model
Builder under the Definitions node. In addition, a multiphysics coupling feature, The
Two-Phase Flow, Level Set Coupling Feature, is added automatically under the
Multiphysics node. The Wetted Wall Coupling Feature is also added, but with empty
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selection. Other Wetted Wall multiphysics coupling features and The Interior Wetted
Wall Coupling Feature can be added when needed to model walls.

Simulations using the Laminar Two-Phase Flow, Level Set interface are always
time-dependent since the position of an interface is almost always dependent of its

history.
INTERFACE PROPERTIES

Discretization

By default the fluid flow discretization is set to PI+P1, and the level set discretization
is set to Linear. This combination provides exact conservation of the integral of the level
set variable when using the nonconservative form of the level set equation.

¢ Domain, Boundary, Edge, Point, and Pair Nodes for the Rotating

Machinery, Two-Phase Flow Interfaces
* Moving Mesh
In the CFD Module User’s Guide:

¢ The Two-Phase Flow, Level Set and Phase Field Interfaces
¢ Theory for the Two-Phase Flow Interfaces
e Theory for the Single-Phase Flow Interfaces

e Theory for the Level Set Interface

The Rotating Machinery, Turbulent Two-Phase Flow, Level Set
Interfuces

The Rotating Machinery, Turbulent Two-Phase Flow, Level Set multiphysics interfaces
) found under the Multiphase Flow>Rotating Machinery, Two-Phase Flow, Level

Set>Turbulent Flow branch (fl ), are multiphysics interfaces designed to track the

interface between two immiscible fluids in equipment containing one or more rotating

parts. The flow is assumed to be turbulent, that is, to be of high Reynolds number.

When adding a Rotating Machinery Turbulent Two-Phase Flow, Level Set multiphysics
interface, a Turbulent Flow interface and a Level Set interface are added in the Model
Builder. A Moving Mesh interface with a Rotating Domain node is added automatically in
the Model Builder under the Definitions node. In addition, a multiphysics coupling

feature, The Two-Phase Flow, Level Set Coupling Feature, is automatically added
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under the Multiphysics node. Other multiphysics coupling features, The Wetted Wall
Coupling Feature and The Interior Wetted Wall Coupling Feature, can be added when
needed to model walls.

* The Turbulent Flow, Algebraic yPlus interface (fl) combines a Level Set interface

with a Turbulent Flow, Algebraic yPlus interface and a Rotating Domain.

e The Turbulent Flow, L-VEL interface (fl) combines a Level Set interface with a

Turbulent Flow, L-VEL interface and a Rotating Domain.

¢ The Turbulent Flow, k-¢ interface ( ,f‘; ) combines a Level Set interface with a

Turbulent Flow, k-¢ interface and a Rotating Domain.

¢ The Turbulent Flow, Realizable k-¢ interface (fl) combines a Level Set interface

with a Turbulent Flow, Realizable k-€ interface and a Rotating Domain.
¢ The Turbulent Flow, k-0 interface (fl) combines a Level Set interface with a

Turbulent Flow, k- interface and a Rotating Domain.

* The Turbulent Flow, SST interface (fl) combines a Level Set interface with a

Turbulent Flow, SST interface and a Rotating Domain.

e The Turbulent Flow, Low Re k-¢ interface ( fl) combines a Level Set interface with

a Turbulent Flow, Low Re k-¢ interface and a Rotating Domain.
e The Turbulent Flow, Spalart-Allmaras interface (fl) combines a Level Set interface

with a Turbulent Flow, Spalart-Allmaras interface and a Rotating Domain.

¢ The Turbulent Flow, v2-f interface ( fl) combines a Level Set interface with a

Turbulent Flow, v2-f interface and a Rotating Domain.

Simulations using the Turbulent Two-Phase Flow, Level Set multiphysics interfaces are
always time-dependent since the position of an interface almost always depends on its

history.
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INTERFACE PROPERTIES

Turbulence Model
By default the Turbulence model type in the settings of the Turbulent Flow interface is
set to RANS. A different turbulence model can be selected under Turbulence model.

In the CFD Module User’s Guide:

e Theory for the Two-Phase Flow Interfaces

@

e Theory for the Single-Phase Flow Interfaces

e Theory for the Level Set Interface

The Rotating Machinery, Laminar Two-Phase Flow, Phase Field
Interface

The Rotating Machinery, Laminar Flow, Phase Field multiphysics interface (Il)) found
under the Multiphase Flow>Rotating Machinery, Two-Phase Flow, Phase Field branch
(fl) ), is a multiphysics interface designed to track the interface between two
immiscible fluids in equipment containing one or more rotating parts. The flow is

assumed to be laminar, that is, to be of low to moderate Reynolds number.

This physics interface combines the capabilities of the Rotating Machinery, Laminar
Flow interface and the Phase Field interface. It is available in 2D and 3D.

When adding the Laminar Two-Phase Flow, Phase Field multiphysics interface, a Laminar
Flow and a Phase Field interface are added to the Model Builder. A Moving Mesh
interface with a Rotating Domain node is added automatically in the Model Builder under
the Definitions node. In addition, a multiphysics coupling feature, The Two-Phase
Flow, Phase Field Coupling Feature, is added automatically under the Multiphysics

node.

Simulations using the Laminar Two-Phase Flow, Phase Field interface are always
time-dependent since the position of an interface is almost always dependent of its

history.
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INTERFACE PROPERTIES

Discretization
By default the fluid flow discretization is set to P1+P1, and the phase field discretization
is set to Linear. This combination provides improved conservation of the integral of the

phase field variable when using the nonconservative form of the phase field equations.

* Domain, Boundary, Edge, Point, and Pair Nodes for the Rotating

Machinery, Two-Phase Flow Interfaces
* Moving Mesh
In the CED Module User’s Guide:

Q

¢ The Two-Phase Flow, Level Set and Phase Field Interfaces
* Theory for the Two-Phase Flow Interfaces
e Theory for the Single-Phase Flow Interfaces

* Theory for the Phase Field Interface

The Rotating Machinery, Turbulent Two-Phase Flow, Phase Field
Interfaces

The Rotating Machinery, Turbulent Two-Phase Flow, Phase Field multiphysics interfaces
(fi) found under the Multiphase Flow>Rotating Machinery, Two-Phase Flow, Phase
Field>Turbulent Flow branch (fl ), are multiphysics interfaces designed to track the
interface between two immiscible fluids in equipment containing one or more rotating
parts. The flow is assumed to be turbulent, that is, to be of high Reynolds number.

When adding a Rotating Machinery Turbulent Two-Phase Flow, Phase Field multiphysics
interface, a Turbulent Flow interface and a Phase Field interface are added in the Model
Builder. A Moving Mesh interface with a Rotating Domain node is added automatically in
the Model Builder under the Definitions node. In addition, a multiphysics coupling
feature, The Two-Phase Flow, Phase Field Coupling Feature, is automatically added
under the Multiphysics node.

* The Turbulent Flow, Algebraic yPlus interface ( kl) combines a Phase Field interface

with a Turbulent Flow, Algebraic yPlus interface and a Rotating Domain.
* The Turbulent Flow, L-VEL interface (kl) combines a Phase Field interface with a

Turbulent Flow, L-VEL interface and a Rotating Domain.
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The Turbulent Flow, k-¢ interface (fi) combines a Phase Field interface with a

Turbulent Flow, k-¢ interface and a Rotating Domain.

The Turbulent Flow, Realizable k-¢ interface ( ffg::) combines a Phase Field interface

with a Turbulent Flow, Realizable k-€ interface and a Rotating Domain.

The Turbulent Flow, k- interface (fl) combines a Phase Field interface with a

Turbulent Flow, k- interface and a Rotating Domain.

The Turbulent Flow, SST interface (fl ) combines a Phase Field interface with a

Turbulent Flow, SST interface and a Rotating Domain.

The Turbulent Flow, Low Re k-¢ interface (fi ) combines a Phase Field interface with

a Turbulent Flow, Low Re k-¢ interface and a Rotating Domain.

The Turbulent Flow, Spalart-Allmaras interface (fl ) combines a Phase Field interface

with a Turbulent Flow, Spalart-Allmaras interface and a Rotating Domain.

The Turbulent Flow, v2-f interface (}l) combines a Phase Field interface with a

Turbulent Flow, v2-finterface and a Rotating Domain.
Simulations using the Turbulent Two-Phase Flow, Phase Field multiphysics interfaces

are always time-dependent since the position of an interface almost always depends on

its history.
INTERFACE PROPERTIES

Turbulence Model
By default the Turbulence model type in the settings of the Turbulent Flow interface is
set to RANS. A different turbulence model can be selected under Turbulence model.

In the CFD Module User’s Guide:

e Theory for the Two-Phase Flow Interfaces

@

* Theory for the Single-Phase Flow Interfaces

e Theory for the Phase Field Interface
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Domain, Boundary, Edge, Point, and Pair Nodes for the Rotating
Machinery, Two-Phase Flow Interfaces

Physics nodes are available from the Physics ribbon toolbar (Windows users), Physics

context menu (Mac or Linux users), or right-click to access the context menu (all

users).
o In general, to add a node, go to the Physics toolbar, no matter what
= operating system you are using.

LEVEL SET

The available physics features for The Level Set Interface are listed in the section
Domain, Boundary, and Pair Nodes for the Level Set Interface.

PHASE FIELD
The available physics features for The Phase Field Interface are listed in the section
Domain, Boundary, and Pair Nodes for the Level Set Interface.

LAMINAR FLOW
The available physics features for The Rotating Machinery, Laminar Flow Interface are
listed in the section Domain, Boundary, Point, and Pair Nodes for the Rotating

Machinery Interfaces.

TURBULENT FLOW, ALGEBRAIC YPLUS

The available physics features for The Rotating Machinery, Turbulent Flow, Algebraic
yPlus Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for
the Rotating Machinery Interfaces.

TURBULENT FLOW, L-VEL
The available physics features for The Rotating Machinery, Turbulent Flow, L-VEL
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the

Rotating Machinery Interfaces.

TURBULENT FLOW, k-¢
The available physics features for The Rotating Machinery, Turbulent Flow, k-€
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the

Rotating Machinery Interfaces.
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TURBULENT FLOW, REALIZABLE k-¢
The available physics features for The Rotating Machinery, Turbulent Flow, Realizable
k-g Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the

Rotating Machinery Interfaces.

TURBULENT FLOW, k-

The available physics features for The Rotating Machinery, Turbulent Flow, k-o
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the
Rotating Machinery Interfaces.

TURBULENT FLOW, SST

The available physics features for The Rotating Machinery, Turbulent Flow, SST
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the
Rotating Machinery Interfaces.

TURBULENT FLOW, LOW RE k-¢
The available physics features for The Rotating Machinery, Turbulent Flow, Low Re
k-¢ Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the

Rotating Machinery Interfaces.

TURBULENT FLOW, SPALART-ALLMARAS
The available physics features for The Rotating Machinery, Turbulent Flow,
Spalart-Allmaras Interface are listed in the section Domain, Boundary, Point, and Pair

Nodes for the Rotating Machinery Interfaces.

TURBULENT FLOW, V2-F
The available physics features for The Rotating Machinery, Turbulent Flow, v2-f
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the

Rotating Machinery Interfaces.

THE TWO-PHASE FLOW, LEVEL SET MULTIPHYSICS COUPLINGS

The Rotating Machinery, Laminar Two-Phase Flow, Level Set Interface and The
Rotating Machinery, Turbulent Two-Phase Flow, Level Set Interfaces contain a
multiphysics coupling feature, The Two-Phase Flow, Level Set Coupling Feature,
which is added automatically. Two more multiphysics couplings are available to model
walls, The Wetted Wall Coupling Feature and The Interior Wetted Wall Coupling

Feature.
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THE TWO-PHASE FLOW, PHASE FIELD MULTIPHYSICS COUPLINGS

The Rotating Machinery, Laminar Two-Phase Flow, Phase Field Interface and The
Rotating Machinery, Turbulent Two-Phase Flow, Phase Field Interfaces contain a
multiphysics coupling feature, The Two-Phase Flow, Phase Field Coupling Feature,
which is added automatically.
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Rotating Machinery,
Nonisothermal Flow Interfaces

This chapter describes the multiphysics interfaces found under the Fluid

Flow>Nonisothermal Flow>Rotating Machinery, Nonisothermal Flow branch (SJ ). In

this chapter:

¢ Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface

* Rotating Machinery, Nonisothermal Flow, Turbulent Flow, Algebraic yPlus

Interface
¢ Rotating Machinery, Nonisothermal Flow, Turbulent Flow, L-VEL Interface
* Rotating Machinery, Nonisothermal Flow, Turbulent Flow, k- Interface

¢ Rotating Machinery, Nonisothermal Flow, Turbulent Flow, Realizable k-

Interface
¢ Rotating Machinery, Nonisothermal Flow, Turbulent Flow, k- Interface
¢ Rotating Machinery, Nonisothermal Flow, Turbulent Flow, SST Interface

¢ Rotating Machinery, Nonisothermal Flow, Turbulent Flow, Low Re k-

Interface

¢ Rotating Machinery, Nonisothermal Flow, Turbulent Flow, k- Interface
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* Rotating Machinery, Nonisothermal Flow, Turbulent Flow, v2-f Interface

e Domain, Boundary, Edge, Point, and Pair Nodes for the Rotating Machinery,
Nonisothermal Flow Interfaces
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The Rotating Machinery,
Nonisothermal Flow, Laminar and
Turbulent Flow Interfaces

Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface

The Laminar Flow version of the Rotating Machinery, Nonisothermal Flow multiphysics
interface (l ), found under the Fluid Flow>Nonisothermal Flow>Rotating Machinery,

Nonisothermal Flow branch (l ) when adding a physics interface, is used to simulate

laminar flow and heat transfer in equipment containing one or more rotating parts.

This physics interface combines the capabilities of the Rotating Machinery, Laminar
Flow interface and the Heat Transfer in Fluids interface, and can be used to simulate
fluid flows where the fluid properties depend on the temperature. Furthermore it is
also possible to include heat transfer in solids, stationary and rotating, as well as
surface-to-surface radiation and radiation in participating media. The physics interface
is available in 2D and 3D and supports low Mach number (typically less than 0.3)
flows, as well as non-Newtonian fluids.

Four study types are available for this physics interface. Using the Time Dependent study
type, the rotation is achieved through moving mesh functionality, also known as sliding
mesh. Using the Frozen Rotor study, the rotating parts are kept frozen in position, and
the rotation is accounted for by the inclusion of centrifugal and Coriolis forces. The
Time Dependent, One-Way NITF and Frozen Rotor, One-Way NITF study are used for frozen
rotor and time dependent nonisothermal flow computations where the temperature
variations are so small that they do not affect the flow.

When adding the multiphysics interface, the Laminar Flow and Heat Transfer in Fluids
interfaces are added to the Model Builder. A Moving Mesh interface with a Rotating
Domain node is added automatically in the Model Builder under the Definitions node. In
addition, the Multiphysics node is added, which automatically includes the multiphysics

coupling feature Nonisothermal Flow. The following default nodes are also added in the
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Model Builder under Laminar Flow — Fluid Properties, Wall, and Initial Values; and under

Heat Transfer in Fluids — Fluid, Thermal Insulation, and Initial Values.

In previous versions of COMSOL Multiphysics (prior to version 5.4), a
specific physics interface called Rotating Machinery, Nonisothermal Flow
(rmnitf) was added to the Model Builder. Now, a predefined multiphysics
coupling approach is used, improving the flexibility and design options

[

for your modeling. For specific details, see The Multiphysics Branch and
Multiphysics Modeling Workflow in the COMSOL Multiphysics
Reference Manual.

* Domain, Boundary, Edge, Point, and Pair Nodes for the Rotating

Machinery, Nonisothermal Flow Interfaces
* Moving Mesh

e Theory for the Free Surface Features
In the CFD Module User’s Guide:

* Modeling Heat Transfer in the CFD Module

* The Nonisothermal Flow and Conjugate Heat Transfer, Laminar Flow,
Turbulent Flow and LES Interfaces

* Theory for the Nonisothermal Flow and Conjugate Heat Transfer

Interfaces

Rotating Machinery, Nonisothermal Flow, Turbulent Flow, Algebraic
yPlus Interface

The Turbulent Flow, Algebraic yPlus version of the Rotating Machinery, Nonisothermal
Flow interface ('ﬁ“l ), found under the Fluid Flow>Nonisothermal Flow>Rotating
Machinery, Nonisothermal Flow branch (l ) when adding a physics interface, is used to
simulate turbulent flow and heat transfer in equipment containing one or more

rotating parts.

This physics interface combines the capabilities of the Rotating Machinery, Turbulent
Flow, Algebraic yPlus interface and the Heat Transfer in Fluids interface, and can be
used to simulate high Reynolds number flows where the fluid properties depend on
the temperature. Furthermore it is also possible to include heat transfer in solids,
stationary and rotating, as well as surface-to-surface radiation and radiation in
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participating media. The physics interface is available in 2D and 3D and supports low

Mach number (typically less than 0.3) flows, as well as non-Newtonian fluids.

The physics interface solves for conservation of energy, mass, and momentum in fluids,
and for conservation of energy in solids. The interface also solves an algebraic equation
for the scaled wall distance. Turbulence effects are included using an enhanced
viscosity model based on the scaled wall distance, and the physics interface therefore

includes a wall distance equation.

Four study types available for this physics interface. Using the Transient with
Initialization study type, the rotation is achieved through moving mesh functionality,
also known as sliding mesh. Using the Frozen Rotor with Initialization study type, the
rotating parts are kept frozen in position, and the rotation is accounted for by the
inclusion of centrifugal and Coriolis forces. The Time Dependent, One-Way NITF and
Frozen Rotor, One-Way NITF study are used for frozen rotor and time dependent
nonisothermal flow computations where the temperature variations are so small that
they do not affect the flow. All study types include an initial Wall Distance Initialization
step in order to compute the wall distance. See Theory for the Rotating Machinery
Interfaces in the CFD Module User’s Guide.

When adding the multiphysics interface, the Turbulent Flow, Algebraic yPlus and Heat
Transfer in Fluids interfaces are added to the Model Builder. A Moving Mesh interface
with a Rotating Domain node is added automatically in the Model Builder under the
Definitions node. In addition, the Multiphysics node is added, which automatically
includes the multiphysics coupling feature Nonisothermal Flow. The following default
nodes are also added in the Model Builder under Turbulent Flow, Algebraic yPlus — Fluid
Properties, Wall, and Initial Values; and under Heat Transfer in Fluids — Fluid, Thermal

Insulation, and Initial Values.

See Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface for details.

Rotating Machinery, Nonisothermal Flow, Turbulent Flow, L-VEL
Interfoce

The Turbulent Flow, L-VEL version of the Rotating Machinery, Nonisothermal Flow
interface (l ), found under the Fluid Flow>Nonisothermal Flow>Rotating Machinery,

Nonisothermal Flow branch (l ) when adding a physics interface, is used to simulate

turbulent flow and heat transfer in equipment containing one or more rotating parts.

This physics interface combines the capabilities of the Rotating Machinery, Turbulent

Flow, L-VEL interface and the Heat Transfer in Fluids interface, and can be used to
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simulate high Reynolds number flows where the fluid properties depend on the
temperature. Furthermore it is also possible to include heat transfer in solids,
stationary and rotating, as well as surface-to-surface radiation and radiation in
participating media. The physics interface is available in 2D and 3D and supports low
Mach number (typically less than 0.3) flows, as well as non-Newtonian fluids.

The physics interface solves for conservation of energy, mass, and momentum in fluids,
and for conservation of energy in solids. The interface also solves an algebraic equation
for the scaled fluid flow velocity tangential to the nearest wall. Turbulence effects are
included using an enhanced viscosity model based on the scaled wall distance, and the

physics interface therefore includes a wall distance equation.

Four study types available for this physics interface. Using the Transient with
Initialization study type, the rotation is achieved through moving mesh functionality,
also known as sliding mesh. Using the Frozen Rotor with Initialization study type, the
rotating parts are kept frozen in position, and the rotation is accounted for by the
inclusion of centrifugal and Coriolis forces. The Time Dependent, One-Way NITF and
Frozen Rotor, One-Way NITF study are used for frozen rotor and time dependent
nonisothermal flow computations where the temperature variations are so small that
they do not affect the flow. All study types include an initial Wall Distance Initialization
step in order to compute the wall distance. See Theory for the Rotating Machinery
Interfaces in the CED Module User’s Guide.

When adding the multiphysics interface, the Turbulent Flow, L-VEL and Heat Transfer in
Fluids interfaces are added to the Model Builder. A Moving Mesh interface with a
Rotating Domain node is added automatically in the Model Builder under the Definitions
node. In addition, the Multiphysics node is added, which automatically includes the
multiphysics coupling feature Nonisothermal Flow. The following default nodes are also
added in the Model Builder under Turbulent Flow, L-VEL — Fluid Properties, Wall, and
Initial Values; and under Heat Transfer in Fluids — Fluid, Thermal Insulation, and Initial

Values.

See Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface for details.

Rotating Machinery, Nonisothermal Flow, Turbulent Flow, k-
Interface

The Turbulent Flow, k-€ version of the Rotating Machinery, Nonisothermal Flow (rmnitf)
interface (7] ), found under the Fluid Flow>Nonisothermal Flow>Rotating Machinery,
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Nonisothermal Flow branch (l ) when adding a physics interface, is used to simulate

turbulent flow and heat transfer in equipment containing one or more rotating parts.

This physics interface combines the capabilities of the Rotating Machinery, Turbulent
Flow, k-¢ interface and the Heat Transfer in Fluids interface, and can be used to
simulate high Reynolds number fluid flows where the fluid properties depend on the
temperature. Furthermore it is also possible to include heat transfer in solids,
stationary and rotating, as well as surface-to-surface radiation and radiation in
participating media. The physics interface is available in 2D and 3D and supports low

Mach number (typically less than 0.3) flows, as well as non-Newtonian fluids.

The physics interface solves for conservation of energy, mass, and momentum in fluids,
and for conservation of energy in solids. Turbulence effects are modeled using the
standard two-equation k-& model with realizability constraints. Flow and heat transfer

close to walls are modeled using wall functions.

Four study types are available for this physics interface. Using the Time Dependent study
type, the rotation is achieved through moving mesh functionality, also known as sliding
mesh. Using the Frozen Rotor study, the rotating parts are kept frozen in position, and
the rotation is accounted for by the inclusion of centrifugal and Coriolis forces. The
Time Dependent, One-Way NITF and Frozen Rotor, One-Way NITF study are used for frozen
rotor and time dependent nonisothermal flow computations where the temperature

variations are so small that they do not affect the flow.

When adding the multiphysics interface, the Turbulent Flow, k-€ and Heat Transfer in
Fluids interfaces are added to the Model Builder. A Moving Mesh interface with a
Rotating Domain node is added automatically in the Model Builder under the Definitions
node. In addition, the Multiphysics node is added, which automatically includes the
multiphysics coupling feature Nonisothermal Flow. The following default nodes are also
added in the Model Builder under Turbulent Flow, k-€ — Fluid Properties, Wall, and Initial

Values; and under Heat Transfer in Fluids — Fluid, Thermal Insulation, and Initial Values.

See Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface for details.

Rotating Machinery, Nonisothermal Flow, Turbulent Flow,
Realizable k-¢ Interface

The Turbulent Flow, Realizable k- version of the Rotating Machinery, Nonisothermal Flow
(rmnitf) interface (J ), found under the Fluid Flow>Nonisothermal Flow>Rotating

Machinery, Nonisothermal Flow branch (J ) when adding a physics interface, is used to
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simulate turbulent flow and heat transfer in equipment containing one or more

rotating parts.

This physics interface combines the capabilities of the Rotating Machinery, Turbulent
Flow, Realizable k-¢ interface and the Heat Transfer in Fluids interface, and can be
used to simulate high Reynolds number fluid flows where the fluid properties depend
on the temperature. Furthermore it is also possible to include heat transfer in solids,
stationary and rotating, as well as surface-to-surface radiation and radiation in
participating media. The physics interface is available in 2D and 3D and supports low
Mach number (typically less than 0.3) flows, as well as non-Newtonian fluids.

The physics interface solves for conservation of energy, mass, and momentum in fluids,
and for conservation of energy in solids. Turbulence effects are modeled using the
Realizable two-equation k-& model. Flow and heat transfer close to walls are modeled

using wall functions.

Four study types are available for this physics interface. Using the Time Dependent study
type, the rotation is achieved through moving mesh functionality, also known as sliding
mesh. Using the Frozen Rotor study, the rotating parts are kept frozen in position, and
the rotation is accounted for by the inclusion of centrifugal and Coriolis forces. The
Time Dependent, One-Way NITF and Frozen Rotor, One-Way NITF study are used for frozen
rotor and time dependent nonisothermal flow computations where the temperature

variations are so small that they do not affect the flow.

When adding the multiphysics interface, the Turbulent Flow, Realizable k-¢ and Heat
Transfer in Fluids interfaces are added to the Model Builder. A Moving Mesh interface
with a Rotating Domain node is added automatically in the Model Builder under the
Definitions node. In addition, the Multiphysics node is added, which automatically
includes the multiphysics coupling feature Nonisothermal Flow. The following default
nodes are also added in the Model Builder under Turbulent Flow, Realizable k-€ — Fluid
Properties, Wall, and Initial Values; and under Heat Transfer in Fluids — Fluid, Thermal

Insulation, and Initial Values.

See Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface for details.

Rotating Machinery, Nonisothermal Flow, Turbulent Flow, k-@
Interface

The Turbulent Flow, k- version of the Rotating Machinery, Nonisothermal Flow
interface (7] ), found under the Fluid Flow>Nonisothermal Flow>Rotating Machinery,
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Nonisothermal Flow branch (l ) when adding a physics interface, is used to simulate

turbulent flow and heat transfer in equipment containing one or more rotating parts.

This physics interface combines the capabilities of the Rotating Machinery, Turbulent
Flow, k- interface and the Heat Transfer in Fluids interface, and can be used to
simulate high Reynolds number fluid flows where the fluid properties depend on the
temperature. Furthermore it is also possible to include heat transfer in solids,
stationary and rotating, as well as surface-to-surface radiation and radiation in
participating media. The physics interface is available in 2D and 3D and supports low

Mach number (typically less than 0.3) flows, as well as non-Newtonian fluids.

The physics interface solves for conservation of energy, mass, and momentum in fluids
and for conservation of energy in solids. Turbulence effects are modeled using the
Wilcox revised two-equation k-® model with realizability constraints. The &2-® model
is a so-called low-Reynolds number model, which means that it can resolve the flow

and heat transfer all the way down to the wall.

Four study types are available for this physics interface. Using the Time Dependent study
type, the rotation is achieved through moving mesh functionality, also known as sliding
mesh. Using the Frozen Rotor study, the rotating parts are kept frozen in position, and
the rotation is accounted for by the inclusion of centrifugal and Coriolis forces. The
Time Dependent, One-Way NITF and Frozen Rotor, One-Way NITF study are used for frozen
rotor and time dependent nonisothermal flow computations where the temperature

variations are so small that they do not affect the flow.

When adding the multiphysics interface, the Turbulent Flow, k-0 and Heat Transfer in
Fluids interfaces are added to the Model Builder. A Moving Mesh interface with a
Rotating Domain node is added automatically in the Model Builder under the Definitions
node. In addition, the Multiphysics node is added, which automatically includes the
multiphysics coupling feature Nonisothermal Flow. The following default nodes are also
added in the Model Builder under Turbulent Flow, k- — Fluid Properties, Wall, and
Initial Values; and under Heat Transfer in Fluids — Fluid, Thermal Insulation, and Initial

Values.

See Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface for details.

Rotating Machinery, Nonisothermal Flow, Turbulent Flow, SST
Interface

The Turbulent Flow, SST version of the Rotating Machinery, Nonisothermal Flow

interface (l ), found under the Fluid Flow>Nonisothermal Flow>Rotating Machinery,
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Nonisothermal Flow branch (l ) when adding a physics interface, is used to simulate

turbulent flow and heat transfer in equipment containing one or more rotating parts.

This physics interface combines the capabilities of the Rotating Machinery, Turbulent
Flow, SST interface and the Heat Transfer in Fluids interface, and can be used to
simulate high Reynolds number fluid flows where the fluid properties depend on the
temperature. Furthermore it is also possible to include heat transfer in solids,
stationary and rotating, as well as surface-to-surface radiation and radiation in
participating media. The physics interface is available in 2D and 3D and supports low
Mach number (typically less than 0.3) flows, as well as non-Newtonian fluids.

The physics interface solves for conservation of energy, mass, and momentum in fluids
and for conservation of energy in solids. Turbulence effects are modeled using the SST
two-equation model with realizability constraints. The SST model is a so-called
low-Reynolds number model, which means that it can resolve the flow and heat
transfer all the way down to the wall. The SST model depends on the distance to the

closest wall. The physics interface therefore includes a wall distance equation.

Four study types available for this physics interface. Using the Transient with
Initialization study type, the rotation is achieved through moving mesh functionality,
also known as sliding mesh. Using the Frozen Rotor with Initialization study type, the
rotating parts are kept frozen in position, and the rotation is accounted for by the
inclusion of centrifugal and Coriolis forces. The Time Dependent, One-Way NITF and
Frozen Rotor, One-Way NITF study are used for frozen rotor and time dependent
nonisothermal flow computations where the temperature variations are so small that
they do not affect the flow. All study types include an initial Wall Distance Initialization
step in order to compute the wall distance. See Theory for the Rotating Machinery
Interfaces in the CFD Module User’s Guide.

When adding the multiphysics interface, the Turbulent Flow, SST and Heat Transfer in
Fluids interfaces are added to the Model Builder. A Moving Mesh interface with a
Rotating Domain node is added automatically in the Model Builder under the Definitions
node. In addition, the Multiphysics node is added, which automatically includes the
multiphysics coupling feature Nonisothermal Flow. The following default nodes are also
added in the Model Builder under Turbulent Flow, SST — Fluid Properties, Wall, and Initial

Values; and under Heat Transfer in Fluids — Fluid, Thermal Insulation, and Initial Values.

See Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface for details.
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Rotating Machinery, Nonisothermal Flow, Turbulent Flow, Low Re
k-€ Interface

The Turbulent Flow, Low Re k-€ version of the Rotating Machinery, Nonisothermal Flow
interface (l ), found under the Fluid Flow>Nonisothermal Flow>Rotating Machinery,

Nonisothermal Flow branch (l ) when adding a physics interface, is used to simulate

turbulent flow and heat transfer in equipment containing one or more rotating parts.

This physics interface combines the capabilities of the Rotating Machinery, Turbulent
Flow, Low Re k-¢ interface and the Heat Transfer in Fluids interface, and can be used
to simulate high Reynolds number fluid flows where the fluid properties depend on
the temperature. Furthermore it is also possible to include heat transfer in solids,
stationary and rotating, as well as surface-to-surface radiation and radiation in
participating media. The physics interface is available in 2D and 3D and supports low

Mach number (typically less than 0.3) flows, as well as non-Newtonian fluids.

The physics interface solves for conservation of energy, mass, and momentum in fluids
and for conservation of energy in solids. Turbulence effects are modeled using the
AKN two-equation k-&¢ model with realizability constraints. The AKN model is a
so-called low-Reynolds number model, which means that it can resolve the flow and
heat transfer all the way down to the wall. The AKN model depends on the distance

to the closest wall. The physics interface therefore includes a wall distance equation.

Four study types available for this physics interface. Using the Transient with
Initialization study type, the rotation is achieved through moving mesh functionality,
also known as sliding mesh. Using the Frozen Rotor with Initialization study type, the
rotating parts are kept frozen in position, and the rotation is accounted for by the
inclusion of centrifugal and Coriolis forces. The Time Dependent, One-Way NITF and
Frozen Rotor, One-Way NITF study are used for frozen rotor and time-dependent
nonisothermal flow computations where the temperature variations are so small that
they do not affect the flow. All study types include an initial Wall Distance Initialization
step in order to compute the wall distance. See Theory for the Rotating Machinery
Interfaces in the CFD Module User’s Guide.

When adding the multiphysics interface, the Turbulent Flow, low Re k- and Heat
Transfer in Fluids interfaces are added to the Model Builder. A Moving Mesh interface
with a Rotating Domain node is added automatically in the Model Builder under the
Definitions node. In addition, the Multiphysics node is added, which automatically
includes the multiphysics coupling feature Nonisothermal Flow. The following default
nodes are also added in the Model Builder under Turbulent Flow, low Re k-¢ — Fluid
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Properties, Wall, and Initial Values; and under Heat Transfer in Fluids — Fluid, Thermal

Insulation, and Initial Values.

See Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface for details.

Rotating Machinery, Nonisothermal Flow, Turbulent Flow,
Spalart-Allmaras Interface

The Turbulent Flow, Spalart-Allmaras version of the Rotating Machinery, Nonisothermal
Flow interface (J ), found under the Fluid Flow>Nonisothermal Flow>Rotating
Machinery, Nonisothermal Flow branch (l ) when adding a physics interface, is used to
simulate turbulent flow and heat transfer in equipment containing one or more

rotating parts.

This physics interface combines the capabilities of the Rotating Machinery, Turbulent
Flow, Spalart-Allmaras interface and the Heat Transfer in Fluids interface, and can be
used to simulate high Reynolds number flows where the fluid properties depend on
the temperature. Furthermore it is also possible to include heat transfer in solids,
stationary and rotating, as well as surface-to-surface radiation and radiation in
participating media. The physics interface is available in 2D and 3D and supports low

Mach number (typically less than 0.3) flows, as well as non-Newtonian fluids.

The physics interface solves for conservation of energy, mass, and momentum in fluids
and for conservation of energy in solids. Turbulence effects are modeled using the
Spalart—Allmaras one-equation model. The Spalart—Allmaras model is a so-called
low-Reynolds number model, which means that it can resolve the flow and heat
transfer all the way down to the wall. The Spalart—Allmaras model depends on the
distance to the closest wall, and the physics interface therefore includes a wall distance

equation.

Four study types available for this physics interface. Using the Transient with
Initialization study type, the rotation is achieved through moving mesh functionality,
also known as sliding mesh. Using the Frozen Rotor with Initialization study type, the
rotating parts are kept frozen in position, and the rotation is accounted for by the
inclusion of centrifugal and Coriolis forces. The Time Dependent, One-Way NITF and
Frozen Rotor, One-Way NITF study are used for frozen rotor and time-dependent
nonisothermal flow computations where the temperature variations are so small that
they do not affect the flow. All study types include an initial Wall Distance Initialization
step in order to compute the wall distance. See Theory for the Rotating Machinery
Interfaces in the CFD Module User’s Guide.
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When adding the multiphysics interface, the Turbulent Flow, Spalart-Allmaras and Heat
Transfer in Fluids interfaces are added to the Model Builder. A Moving Mesh interface
with a Rotating Domain node is added automatically in the Model Builder under the
Definitions node. In addition, the Multiphysics node is added, which automatically
includes the multiphysics coupling feature Nonisothermal Flow. The following default
nodes are also added in the Model Builder under Turbulent Flow, Spalart-Allmaras — Fluid
Properties, Wall, and Initial Values; and under Heat Transfer in Fluids — Fluid, Thermal

Insulation, and Initial Values.

See Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface for details.

Rotating Machinery, Nonisothermal Flow, Turbulent Flow, v2-f
Interface

The Turbulent Flow, v2-f version of the Rotating Machinery, Nonisothermal Flow
interface (l ), found under the Fluid Flow>Nonisothermal Flow>Rotating Machinery,

Nonisothermal Flow branch (l ) when adding a physics interface, is used to simulate

turbulent flow and heat transfer in equipment containing one or more rotating parts.

This physics interface combines the capabilities of the Rotating Machinery, Turbulent
Flow, v2-finterface and the Heat Transfer in Fluids interface, and can be used to
simulate high Reynolds number flows where the fluid properties depend on the
temperature. Furthermore it is also possible to include heat transfer in solids,
stationary and rotating, as well as surface-to-surface radiation and radiation in
participating media. The physics interface is available in 2D and 3D and supports low

Mach number (typically less than 0.3) flows, as well as non-Newtonian fluids.

The physics interface solves for conservation of energy, mass, and momentum in fluids
and for conservation of energy in solids. Turbulence effects are modeled using the v2-f
transport-equation model with realizability constraints. The v2-f model is a so-called
low-Reynolds number model, which means that it can resolve the flow and heat
transfer all the way down to the wall. The physics interface includes a wall distance

equation.

Four study types available for this physics interface. Using the Transient with
Initialization study type, the rotation is achieved through moving mesh functionality,
also known as sliding mesh. Using the Frozen Rotor with Initialization study type, the
rotating parts are kept frozen in position, and the rotation is accounted for by the
inclusion of centrifugal and Coriolis forces. The Time Dependent, One-Way NITF and

Frozen Rotor, One-Way NITF study are used for frozen rotor and time dependent
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nonisothermal flow computations where the temperature variations are so small that
they do not affect the flow. All study types include an initial Wall Distance Initialization
step in order to compute the wall distance. See Theory for the Rotating Machinery
Interfaces in the CFD Module User’s Guide.

When adding the multiphysics interface, the Turbulent Flow, v2-f and Heat Transfer in
Fluids interfaces are added to the Model Builder. A Moving Mesh interface with a
Rotating Domain node is added automatically in the Model Builder under the Definitions
node. In addition, the Multiphysics node is added, which automatically includes the
multiphysics coupling feature Nonisothermal Flow. The following default nodes are also
added in the Model Builder under Turbulent Flow, v2-f — Fluid Properties, Wall, and
Initial Values; and under Heat Transfer in Fluids — Fluid, Thermal Insulation, and Initial

Values.

See Rotating Machinery, Nonisothermal Flow, Laminar Flow Interface for details.

Domain, Boundary, Edge, Point, and Pair Nodes for the Rotating
Machinery, Nonisothermal Flow Interfaces

Physics nodes are available from the Physics ribbon toolbar (Windows users), Physics
context menu (macOS or Linux users), or right-click to access the context menu (all

users).

In general, to add a node, go to the Physics toolbar, no matter what

= operating system you are using.

HEAT TRANSFER IN FLUIDS (NONISOTHERMAL FLOW)
The available physics features for The Heat Transfer in Fluids Interface are listed in the
section The Heat Transfer in Solids and Fluids Interface. Also see Fluid for details

about that feature.

LAMINAR FLOW
The available physics features for The Rotating Machinery, Laminar Flow Interface are
listed in the section Domain, Boundary, Point, and Pair Nodes for the Rotating

Machinery Interfaces.
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TURBULENT FLOW, ALGEBRAIC YPLUS

The available physics features for The Rotating Machinery, Turbulent Flow, Algebraic
yPlus Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for
the Rotating Machinery Interfaces.

TURBULENT FLOW, L-VEL
The available physics features for The Rotating Machinery, Turbulent Flow, L-VEL
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the
Rotating Machinery Interfaces.

TURBULENT FLOW, k-t

The available physics features for The Rotating Machinery, Turbulent Flow, k-€
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the
Rotating Machinery Interfaces.

TURBULENT FLOW, REALIZABLE k-¢

The available physics features for The Rotating Machinery, Turbulent Flow, Realizable
k-¢ Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the
Rotating Machinery Interfaces.

TURBULENT FLOW, k-0

The available physics features for The Rotating Machinery, Turbulent Flow, k-o
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the
Rotating Machinery Interfaces.

TURBULENT FLOW, SST
The available physics features for The Rotating Machinery, Turbulent Flow, SST
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the

Rotating Machinery Interfaces.

TURBULENT FLOW, LOW RE k-¢
The available physics features for The Rotating Machinery, Turbulent Flow, Low Re
k-¢ Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the

Rotating Machinery Interfaces.

TURBULENT FLOW, SPALART-ALLMARAS

The available physics features for The Rotating Machinery, Turbulent Flow,
Spalart-Allmaras Interface are listed in the section Domain, Boundary, Point, and Pair
Nodes for the Rotating Machinery Interfaces.
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TURBULENT FLOW, V2-F
The available physics features for The Rotating Machinery, Turbulent Flow, v2-f

Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the

Rotating Machinery Interfaces.
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Rotating Machinery,
Reacting Flow Interfaces

This chapter describes the physics interfaces found under the Chemical Species

Transport>Rotating Machinery, Reacting Flow branch (=x).

In this chapter:

The Rotating Machinery, Reacting Flow, Laminar Flow Interface

The Rotating Machinery, Reacting Flow, Turbulent Flow, k-€ Interface

The Rotating Machinery, Reacting Flow, Turbulent Flow, k- Interface

The Rotating Machinery, Reacting Flow, Turbulent Flow, SST Interface

The Rotating Machinery, Reacting Flow, Turbulent Flow, Low Re k-¢ Interface

Domain, Boundary, Point, and Pair Nodes for the Rotating Machinery, Reacting

Flow Interfaces
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The Rotating Machinery, Reacting
Flow, Laminar Flow and Turbulent
Flow Interfaces

The Rotating Machinery, Reacting Flow, Laminar Flow Interface

The Laminar Flow version of the Rotating Machinery, Reacting Flow interface (J) is
used to simulate the laminar flow and transport of chemical species in equipment
containing one or more rotating parts. Reactions between the participating species can
also be studied.

The physics interface combines the functionality of the Rotating Machinery, Laminar
Flow and the Transport of Concentrated Species interfaces. The Reacting Flow
multiphysics coupling, which is added automatically, couples fluid flow and mass
transport. The instantaneous velocity and pressure fields are solved together with an
arbitrary number of mass fractions. The momentum balance is governed by the
Navier-Stokes equations, and the total mass conservation is governed by the continuity
equation. For the chemical species, the governing transport equations include

convection, diffusion and, optionally, migration in an electric field.

There are two study types available for this physics interface. For the Time Dependent
study type the rotation is achieved by moving mesh functionality, also known as sliding
mesh. For the Frozen Rotor study type (see Frozen Rotor in the CFD Module User’s
Guide), the rotating parts are kept frozen in position, and the rotation is accounted

for by the inclusion of centrifugal and Coriolis forces.

When adding the multiphysics interface, the Laminar Flow and Transport of
Concentrated Species interfaces are added to the Model Builder. A Moving Mesh interface
with a Rotating Domain node is added automatically in the Model Builder under the
Definitions node. In addition, the Multiphysics node is added, which automatically
includes the multiphysics coupling feature Reacting Flow. The following default nodes

are also added in the Model Builder under Laminar Flow — Fluid Properties, Wall, and
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Initial Values; and under Transport of Concentrated Species — Transport Properties, No

Flux, and Initial Values.

In previous versions of COMSOL Multiphysics (prior to version 5.4), a
specific physics interface called Rotating Machinery, Reacting Flow (rmrf)
was added to the Model Builder. Now, a predefined multiphysics coupling
approach is used, improving the flexibility and design options for your

!

modeling. For specific details, see The Multiphysics Branch and
Multiphysics Modeling Workflow in the COMSOL Multiphysics
Reference Manual.

* The Rotating Machinery, Fluid Flow Interfaces
* Moving Mesh
e Theory for the Free Surface Features

In the CED Module User’s Guide:

{?}‘ e The Reacting Flow Multiphysics Interfaces
e The Transport of Concentrated Species Interface
e Theory for the Rotating Machinery Interfaces
e Theory for the Reacting Flow Interfaces

e Theory for the Transport of Concentrated Species Interface

The Rotating Machinery, Reacting Flow, Turbulent Flow, k-
Interface

The Turbulent Flow, k-€ version of the Rotating Machinery, Reacting Flow interface (Jé ),
found under the Rotating Machinery, Reacting Flow>Turbulent Flow branch (Jiv’, ywhen
adding a physics interface, is used to simulate the turbulent flow and mixing of
chemical species in equipment containing one or more rotating parts. Reactions

between the participating species can also be studied.

This physics interface combines the functionality of the Rotating Machinery, Turbulent
Flow, k-e and the Transport of Concentrated Species interfaces. The Reacting Flow
multiphysics coupling, which is added automatically, couples fluid flow and mass
transport. The averaged velocity and pressure fields are solved together with an

arbitrary number of averaged mass fractions. The momentum balance is governed by
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the averaged Navier-Stokes equations, and the total mass conservation is governed by
the continuity equation. The fluid-flow turbulence is modeled using the standard
two-equation k-& model with realizability constraints. For the chemical species, the
governing transport equations include convection, diffusion and, optionally, migration
in an electric field. Flow close to solid walls is modeled using wall functions for the flow
and species transport. Turbulent reactions are modeled using the eddy dissipation

model.

There are two study types available for this physics interface. For the Time Dependent
study type the rotation is achieved by moving mesh functionality, also known as sliding
mesh. For the Frozen Rotor study type the rotating parts are kept frozen in position,

and the rotation is accounted for by the inclusion of centrifugal and Coriolis forces.

When adding the multiphysics interface, the Turbulent Flow, k-¢ and Transport of
Concentrated Species interfaces are added to the Model Builder. A Moving Mesh interface
with a Rotating Domain node is added automatically in the Model Builder under the
Definitions node. In addition, the Multiphysics node is added, which automatically
includes the multiphysics coupling feature Reacting Flow. The following default nodes
are also added in the Model Builder under Turbulent Flow, k-¢ — Fluid Properties, Wall,
and Initial Values; and under Transport of Concentrated Species — Transport Properties,

No Flux, and Initial Values.

See The Rotating Machinery, Reacting Flow, Laminar Flow Interface for details.

In previous versions of COMSOL Multiphysics (prior to version 5.4), a
specific physics interface called Rotating Machinery, Reacting Flow (rmrf)
was added to the Model Builder. Now, a predefined multiphysics coupling
approach is used, improving the flexibility and design options for your

[

modeling. For specific details, see The Multiphysics Branch and
Multiphysics Modeling Workflow in the COMSOL Multiphysics
Reference Manual.

The Rotating Machinery, Reacting Flow, Turbulent Flow, k-@
Interface

The Turbulent Flow k- version of the Rotating Machinery, Reacting Flow interface ( Jé ),
found under the Rotating Machinery, Reacting Flow>Turbulent Flow branch (12 ) when

adding a physics interface, is used to simulate the turbulent flow and mixing of
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chemical species in equipment containing one or more rotating parts. Reactions

between the participating species can also be studied.

The physics interface combines the functionality of the Rotating Machinery, Turbulent
Flow k-w and the Transport of Concentrated Species interfaces. The Reacting Flow
multiphysics coupling, which is added automatically, couples fluid flow and mass
transport. The averaged velocity and pressure fields are solved together with an
arbitrary number of averaged mass fractions. The momentum balance is governed by
the averaged Navier-Stokes equations, and the total mass conservation is governed by
the continuity equation. The fluid-flow turbulence is modeled using the Wilcox
revised £-® model with realizability constraints. The 2-® model is a so-called
low-Reynolds number model, which means that it can resolve the velocity, pressure
and mass fractions all the way down to the wall. For the chemical species, the
governing transport equations include convection, diffusion and, optionally, migration

in an electric field. Turbulent reactions are modeled using the eddy dissipation model.

There are two study types available for this physics interface. For the Time Dependent
study type the rotation is achieved by moving mesh functionality, also known as sliding
mesh. For the Frozen Rotor study type the rotating parts are kept frozen in position,

and the rotation is accounted for by the inclusion of centrifugal and Coriolis forces.

When adding the multiphysics interface, the Turbulent Flow, k-® and Transport of
Concentrated Species interfaces are added to the Model Builder. A Moving Mesh interface
with a Rotating Domain node is added automatically in the Model Builder under the
Definitions node. In addition, the Multiphysics node is added, which automatically
includes the multiphysics coupling feature Reacting Flow. The following default nodes
are also added in the Model Builder under Turbulent Flow, k-0 — Fluid Properties, Wall,
and Initial Values; and under Transport of Concentrated Species — Transport Properties,

No Flux, and Initial Values.

See The Rotating Machinery, Reacting Flow, Laminar Flow Interface for details.

In previous versions of COMSOL Multiphysics (prior to version 5.4), a
specific physics interface called Rotating Machinery, Reacting Flow (rmrf)
was added to the Model Builder. Now, a predefined multiphysics coupling

approach is used, improving the flexibility and design options for your

m

modeling. For specific details, see The Multiphysics Branch and
Multiphysics Modeling Workflow in the COMSOL Multiphysics
Reference Manual.
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The Rotating Machinery, Reacting Flow, Turbulent Flow, SST
Interface

The Turbulent Flow, SST version of the Rotating Machinery, Reacting Flow interface (JZ ),
found under the Rotating Machinery, Reacting Flow>Turbulent Flow branch (12 ) when
adding a physics interface, is used to simulate the turbulent flow and mixing of
chemical species in equipment containing one or more rotating parts. Reactions

between the participating species can also be studied.

The physics interface combines the functionality of the Rotating Machinery, Turbulent
Flow, SST and the Transport of Concentrated Species interface. The Reacting Flow
multiphysics coupling, which is added automatically, couples fluid flow and mass
transport. The averaged velocity and pressure fields are solved together with an
arbitrary number of averaged mass fractions. The momentum balance is governed by
the averaged Navier-Stokes equations, and the total mass conservation is governed by
the continuity equation. The fluid-flow turbulence is modeled using the SST
two-equation model with realizability constraints. The SST model is a so-called
low-Reynolds number model, which means that it can resolve the velocity, pressure
and mass fractions all the way down to the wall. For this reason the physics interface
can be used to study mass transfer at high Schmidt numbers. The SST model depends
on the distance to the closest wall, and the physics interface therefore includes a wall
distance equation. For the chemical species, the governing transport equations include
convection, diffusion and, optionally, migration in an electric field. Turbulent reactions

are modeled using the eddy dissipation model.

There are two study types available for this physics interface. For the Time Dependent

with Initialization study type the rotation is achieved by moving mesh functionality, also
known as sliding mesh. For the Frozen Rotor with Initialization study type the rotating
parts are kept frozen in position, and the rotation is accounted for by the inclusion of
centrifugal and Coriolis forces. In both study types initialization is performed by first

solving for the distance to the closest wall.

When adding the multiphysics interface, the Turbulent Flow, SST and Transport of
Concentrated Species interfaces are added to the Model Builder. A Moving Mesh interface
with a Rotating Domain node is added automatically in the Model Builder under the
Definitions node. In addition, the Multiphysics node is added, which automatically
includes the multiphysics coupling feature Reacting Flow. The following default nodes
are also added in the Model Builder under Turbulent Flow, SST — Fluid Properties, Wall,
and Initial Values; and under Transport of Concentrated Species — Transport Properties,

No Flux, and Initial Values.
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See The Rotating Machinery, Reacting Flow, Laminar Flow Interface for details.

In previous versions of COMSOL Multiphysics (prior to version 5.4), a
specific physics interface called Rotating Machinery, Reacting Flow (rmrf)
was added to the Model Builder. Now, a predefined multiphysics coupling
approach is used, improving the flexibility and design options for your

i

modeling. For specific details, see The Multiphysics Branch and
Multiphysics Modeling Workflow in the COMSOL Multiphysics
Reference Manual.

The Rotating Machinery, Reacting Flow, Turbulent Flow, Low Re k-
Interface

The Turbulent Flow, Low Re k-g version of the Rotating Machinery, Reacting Flow
interface (lé ), found under the Rotating Machinery, Reacting

Flow>Turbulent Flow branch ( Jé ) when adding a physics interface, is used to simulate
the turbulent flow and mixing of chemical species in equipment containing one or

more rotating parts. Reactions between the participating species can also be studied.

The physics interface combines the functionality of the Rotating Machinery, Turbulent
Flow, Low Re k-e and the Transport of Concentrated Species interfaces. It solves for the
averaged velocity and pressure fields, together with an arbitrary number of averaged
mass fractions. The momentum balance is governed by the averaged Navier-Stokes
equations, and the total mass conservation is governed by the continuity equation. The
fluid-flow turbulence is modeled using the AKN low-Reynolds number %-& model.
The low-Reynolds number model can resolve the velocity, pressure and mass fractions
all the way down to the wall. For this reason the physics interface is suited for studying
mass transfer at high Schmidt numbers. The AKN model depends on the distance to
the closest wall, and the physics interface therefore includes a wall distance equation.
For the chemical species, the governing transport equations include convection,
diffusion and, optionally, migration in an electric field. Turbulent reactions are

modeled using the eddy dissipation model.

There are two study types available for this physics interface. For the Time Dependent

with Initialization study type the rotation is achieved by moving mesh functionality, also
known as sliding mesh. For the Frozen Rotor with Initialization study type the rotating
parts are kept frozen in position, and the rotation is accounted for by the inclusion of
centrifugal and Coriolis forces. In both study types initialization is performed by first

solving for the distance to the closest wall.
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When adding the multiphysics interface, the Turbulent Flow, Low Re k-€ and Transport
of Concentrated Species interfaces are added to the Model Builder. A Moving Mesh
interface with a Rotating Domain node is added automatically in the Model Builder under
the Definitions node. In addition, the Multiphysics node is added, which automatically
includes the multiphysics coupling feature Reacting Flow. The following default nodes
are also added in the Model Builder under Turbulent Flow, Low Re k-¢ — Fluid Properties,
Wall, and Initial Values; and under Transport of Concentrated Species — Transport

Properties, No Flux, and Initial Values.

See The Rotating Machinery, Reacting Flow, Laminar Flow Interface for details.

In previous versions of COMSOL Multiphysics (prior to version 5.4), a
specific physics interface called Rotating Machinery, Reacting Flow (rmrf)
was added to the Model Builder. Now, a predefined multiphysics coupling

approach is used, improving the flexibility and design options for your

[

modeling. For specific details, see The Multiphysics Branch and
Multiphysics Modeling Workflow in the COMSOL Multiphysics
Reference Manual.

Domain, Boundary, Point, and Pair Nodes for the Rotating
Machinery, Reacting Flow Interfaces

Physics nodes are available from the Physics ribbon toolbar (Windows users), Physics
context menu (Mac or Linux users), or right-click to access the context menu (all

users).

In general, to add a node, go to the Physics toolbar, no matter what

= operating system you are using.

LAMINAR FLOW
The available physics features for The Rotating Machinery, Laminar Flow Interface are
listed in the section Domain, Boundary, Point, and Pair Nodes for the Rotating

Machinery Interfaces.
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TURBULENT FLOW, k-
The available physics features for The Rotating Machinery, Turbulent Flow, k-€
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the

Rotating Machinery Interfaces.

TURBULENT FLOW, k-

The available physics features for The Rotating Machinery, Turbulent Flow, k-o
Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the
Rotating Machinery Interfaces.

TURBULENT FLOW, SST

The available physics features for The Rotating Machinery, Turbulent Flow, SST
Interface interface are listed in the section Domain, Boundary, Point, and Pair Nodes
for the Rotating Machinery Interfaces.

TURBULENT FLOW, LOW RE k-¢
The available physics features for The Rotating Machinery, Turbulent Flow, Low Re
k-¢ Interface are listed in the section Domain, Boundary, Point, and Pair Nodes for the

Rotating Machinery Interfaces.

TRANSPORT OF CONCENTRATED SPECIES

The available physics features for The Transport of Concentrated Species Interface are
listed in the section Domain, Boundary, and Pair Nodes for the Transport of
Concentrated Species Interface in the CED Module User’s Guide.
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